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KATA SAMBUTANKATA SAMBUTAN

Menuju  masyarakat  informasi  berbasis  pengetahuan  merupakan  tujuan  yang 
hendak dicapai oleh bangsa Indonesia, khususnya dalam menciptakan dan meningkatkan 
kemandirian bangsa.  Untuk itu berbagai kegiatan dan aktivitas dalam mencapai tujuan 
tersebut perlu dilakukan secara bertahap dan berkesinambungan. 

Terkait dengan upaya tersebut, Kementerian Negara Riset dan Teknologi (KNRT) 
dalam  hal  ini  Asisten  Deputi  Pengembangan  dan  Pemanfaatan  Teknologi  Informasi 
merasa terpanggil untuk ikut berpartisipasi, mendukung dan mendorong program tersebut 
guna  terciptanya  kemandirian  bangsa,  sesuai  dengan  tugas,  fungsi  dan  tanggung 
jawabnya.  

Melalui  semangat  Indonesia,  Go  Open  Source!  (IGOS) dengan  berbagai 
manfaatnya  berkeinginan  turut  serta  untuk  membesarkan  program  Buku  Sekolah 
Elektronik (BSE) yang telah dicanangkan oleh Departemen Pendidikan Nasional Republik 
Indonesia. 

Salah  satu  wujud  nyata  untuk  mensukseskan  program BSE  adalah  melakukan 
kerjasama  dengan  para  narasumber  dan  penulis  buku  Teknologi  Informasi  dan 
Komunikasi (TIK), khususnya berbasis  Open source untuk menerbitkan buku pelajaran 
TIK  bagi  siswa/siswi  Sekolah  Menengah  Atas/  Madrasah  Aliyah  (SMA/MA)  dan 
pendidikan lain  yang sederajat.  Kontribusi  yang kami berikan sangat  kecil  dan masih 
sangat jauh dari kesempurnaan. Namun demikian, kami berharap dengan awal yang kecil 
ini selanjutnya akan memberikan dampak luas di masa yang akan datang bagi bangsa dan 
negara Indonesia.
       Diharapkan terbitan  ini  dapat  dimanfaatkan  bagi  para  siswa/siswi  (SMA/MA). 
Dengan  demikian,  pengenalan,  penggunaan  dan  pemanfaatan  open  source dapat 
berlangsung  sejak  dini,  dan  sekaligus  dapat  menumbuhkembangkan  kreativitas  dalam 
menciptakan piranti lunak berbasis Open Source.     
         

Jakarta, 28 Oktober 2008

Kemal Prihatman 
Asisten Deputi  Pengembangan dan Pemanfaatan Teknologi Informasi
Kementerian Negara Riset dan Teknologi Republik Indonesia
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KATA SAMBUTANKATA SAMBUTAN

Buku merupakan salah satu sarana penting dalam upaya meningkatkan mutu pendidikan. Salah 
satu permasalahan perbukuan dalam era otonomi daerah dewasa ini adalah ketersediaan buku yang 
memenuhi standar nasional pendidikan dengan harga murah yang dapat dijangkau oleh masyarakat 
luas.  Untuk mengatasi hal tersebut,  Departemen Pendidikan Nasional telah membeli 407 hak cipta 
buku teks pelajaran dari penulis/penerbit. 

Buku-buku  teks  pelajaran  SD,  SMP,  SMA  dan  SMK  yang  telah  dinilai  dan  dinyatakan 
memenuhi  syarat  kelayakan  untuk  digunakan  di  dalam  proses  pembelajaran  oleh  Badan  Standar 
Nasional Pendidikan (BSNP) ini ditetapkan melalui Peraturan Menteri Pendidikan Nasional Nomor 34 
Tahun 2008.

Buku-buku yang hak ciptanya telah dimiliki  oleh Departemen Pendidikan Nasional tersebut 
kemudian dialihformatkan oleh Pustekkom menjadi buku elektronik (e-book) yang penyebarluasannya 
dilakukan  melalui  media  web  BSE  yang  beralamat  di  bse.depdiknas.go.id dan  cakram  digital 
(CD/DVD). Seluruh buku telah diunggah (upload) ke web BSE dan saat ini buku-buku tersebut dapat 
diunduh  (download),  digandakan,  dicetak,  dialih-mediakan,  atau  difotokopi  secara  bebas  oleh 
masyarakat.  Namun  untuk  penggandaan  yang  bersifat  komersial,  maka  harga  penjualannya  harus 
memenuhi  Harga  Eceran  Tertinggi  (HET)  yang  telah  ditetapkan  oleh  Pemerintah.  Dengan  melalui 
Jardiknas diharapkan buku-buku teks pelajaran murah ini mudah diakses oleh siswa dan guru di seluruh 
Indonesia maupun Sekolah Indonesia yang berada di luar negeri.

Dari tahun ke tahun jumlah buku teks pelajaran tersebut akan ditambah sehingga kebutuhan 
masyarakat  terhadap  buku  murah  dapat  terpenuhi.  Disamping  menyediakan  buku  murah  sendiri, 
Departemen Pendidikan Nasional menyambut baik dukungan dan sumbangan buku-buku teks pelajaran 
lain dari lembaga atau mitra kerja.

Salah satu mitra yang telah memberikan perhatian pada upaya untuk menyediakan buku teks 
pelajaran adalah Kementerian Negara Riset dan Teknologi yang pada tahun 2008 ini telah bersedia 
menghibahkan hak cipta 6 (enam) buah buku teks pelajaran Teknologi Informasi dan Komunikasi (TIK) 
berbasis Open Source untuk SMA kelas X, XI dan XII kepada Departemen Pendidikan Nasional. Buku-
buku tersebut akan diunggah dan disebarluaskan melalui web BSE sehingga masyarakat nantinya dapat 
mengunduh,  menggandakan,  mencetak,  mengalihmediakan,  atau  memfotokopinya  kapan  saja  dan 
dimana saja.

Untuk  itu  kami  menyampaikan  penghargaan  yang  setinggi-tingginya  kepada  Kementerian 
Negara Riset dan Teknologi yang telah berkenan menyerahkan buku teks pelajaran TIK tersebut kepada 
Departemen Pendidikan Nasional  untuk digunakan secara luas oleh para siswa dan guru di  seluruh 
Indonesia.

Kami berharap semua pihak dapat mendukung kebijakan ini. Kepada para siswa kami ucapkan 
selamat belajar dan manfaatkanlah serta terapkanlah buku ini dengan sebaik-baiknya. Kita menyadari 
bahwa buku ini masih perlu ditingkatkan mutunya.  Oleh karena itu, sumbang saran dan kritik sangat 
kami harapkan.

Jakarta, Oktober 2008
Kepala Pusat Teknologi Informasi dan Komunikasi Pendidikan
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KATA PENGANTAR KATA PENGANTAR 

Buku  pelajaran  TIK  (Teknologi  Informasi  dan  Komunikasi)  untuk  SMA/MA 
berbasis  FOSS  (Free/Open  Source  Software)  ini  disusun  berdasarkan  kurikulum 
pendidikan nasional KTSP (Kurikulum Tingkat Satuan Pendidikan). Penerbitan buku ini 
diharapkan dapat melengkapi koleksi buku-buku sekolah elektronik yang telah diterbitkan 
Departemen  Pendidikan  Nasional  dan  didistribusikan  melalui  web 
http://bse.depdiknas.go.id. 

Perangkat  lunak  atau  program  komputer  yang  digunakan  sebagai  bahan 
pembelajaran di buku ini berlisensi bebas atau merdeka, lisensi yang menjadi ciri khas 
perangkat  lunak  FOSS.  Para  guru  dan  siswa  dapat  memperoleh  semua  program  yang 
digunakan dalam buku ini tanpa harus membayar lisensi kepada pembuatnya. Perangkat 
lunak FOSS seperti  sistem operasi  Linux  dan  aplikasi  OpenOffice.org  dapat  diperoleh 
dengan cara men-download dari Internet, meng-copy CD yang disertakan dalam buku atau 
majalah, atau membeli dari penyedia CD/DVD lainnya.

Buku yang diterbitkan oleh Kementerian Negara Riset dan Teknologi ini disusun 
oleh para pengajar dan penulis yang telah lama berkecimpung di dunia pendidikan maupun 
dunia kepenulisan buku-buku TIK. Sebagian besar materi yang terdapat di buku ini telah 
digunakan  di  laboratorium  komputer  pada  beberapa  SMA  yang  dikelola  oleh  Divisi 
Pendidikan Sekolah LP3T-NF (Lembaga Pendidikan dan Pengembangan Profesi Terpadu – 
Nurul Fikri). 

Rangkaian buku TIK untuk SMA/MA berbasis FOSS ini terdiri atas 6 judul sesuai 
dengan kelas dan semester. Buku kelas X semester I membahas sistem operasi komputer 
dan berbagai aplikasi komputer, sementara buku kelas X semester II membahas aplikasi 
pengolah kata (word processor). Buku kelas XI semester I membahas Internet, sementara 
buku kelas  XI semester II  membahas pengolah angka atau lembar  kerja  (spreadsheet). 
Buku kelas XII semester I  membahas program untuk desain grafis,  termasuk pengolah 
gambar bitmap dan vektor. Buku kelas XII semester II membahas program presentasi.

Kami ucapkan terima kasih kepada semua pihak yang telah membantu  penyusunan 
dan  penerbitan buku ini.  Kami menunggu kritik  dan saran Anda demi penyempurnaan 
buku ini dan buku-buku lain yang akan kami susun untuk mencerdaskan generasi muda 
bangsa  Indonesia.  Kritik  dan  saran  dapat  dikirim  melalui  email  ke  alamat  penulis-
buku@nurulfikri.com. 

Jakarta, 28 Oktober 2008

Penyusun:
Onno W. Purbo, Julianto Arief Setiadi, Lusi Endang
Bayu Pratama, Nanang Kuswana, Siswanto, Saruri
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PETUNJUK PENGGUNAAN BUKUPETUNJUK PENGGUNAAN BUKU

DESKRIPSI UMUMDESKRIPSI UMUM

Buku ini disusun berdasarkan Kurikulum Tingkat Satuan Pelajaran (KTSP) 2006 untuk 
mata pelajaran  Teknologi Informasi dan Komputer kelas XII semester 1. Pokok bahasan 
utama yang dibahas dalam buku ini adalah:

● Mengenal gambar digital
● Mengenal Inkscape
● Membuat objek dengan menu dan ikon pada Inkscape
● Berkreasi dengan Inkscape
● Menu dan ikon pada Gimp
● Membuat objek dasar pada Gimp
● Efek gambar pada Gimp
● Berkreasi dengan Gimp

1.1. PETA KOMPETENSIPETA KOMPETENSI

Secara umum, buku ini mengacu pada Standar Kompetensi dan Kompetensi Dasar (SK & 
KD) bagi SMA seperti yang tercantum dalam tabel berikut. 

Standar Kompetensi Kompetensi Dasar Bab

Menggunakan  perangkat  lunak 
pembuat  grafis  vektor  dan 
bitmap.

Membedakan  jenis  gambar/grafis  bitmap  atau  raster 
dengan gambar/grafis vektor.

1

Menunjukkan menu ikon yang terdapat dalam perangkat 
lunak grafis vektor.

2

Membuat dan mengedit gambar vektor.

Menunjukkan menu ikon yang terdapat dalam perangkat 
lunak grafis bitmap.

Membuat dan mengedit gambar bitmap.

3, 4

5

6, 7, 8

Secara rinci, kompetensi dasar (KD) yang dibahas dalam buku ini tercantum pada tabel 
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berikut.

Kompetensi Dasar Bab

Mengenal gambar digital 1

Gambar bitmap dan vektor 1

Mengenal Inkscape 2

Menu dan ikon pada Inkscape 2

Membuat objek pada Inskcape 3

Menggunakan ikon-ikon di toolbox 3

Berkreasi dengan Inkscape 4

Membuat gambar vektor 4

Menu dan ikon pada Gimp 5

Tool pada Gimp 5

Membuat objek dasar Gimp 6

Mengatur layout gambar 6

Efek gambar pada Gimp 7

Penggunaan filters, phyton-fu, dan script-fu 7

Berkreasi dengan Gimp 8

Membuat gambar bitmap 8

2.2. CARA MENGGUNAKAN BUKU CARA MENGGUNAKAN BUKU 

Buku ini secara khusus ditujukan untuk siswa dan guru SMA atau yang sederajat yang 
mengikuti dan mengampu pembelajaran Teknologi Informasi dan Komuter (TIK). Namun 
demikian, buku ini juga dapat digunakan oleh pembaca umum yang berminat dalam dunia 
Teknologi Informasi dan Komputer. Buku ini dapat dijadikan buku pegangan siswa karena 
ini menyediakan bahan-bahan pelajaran yang lengkap untuk mata pelajaran TIK di tingkat 
SMA/MA.  Beberapa  bagian  dari  buku  ini  mungkin  memerlukan  buku-buku  referensi 
tambahan untuk lebih memperkaya wawasan dan peningkatan kemampuan. Bagi guru, 
buku  ini  dapat  digunakan  sebagai  referensi  untuk  menyusun  modul-modul  ajar  bagi 
peserta didiknya. 
Buku ini disusun sedemikian rupa agar siswa dapat belajar secara mandiri dan terdorong 
untuk mencoba secara langsung. Oleh karena itu, dalam buku ini terdapat banyak ilustrasi 
baik  yang  berupa  gambar,  skema maupun listing  program.  Hal  ini  dimaksudkan agar 
siswa  dapat  dengan  mudah  memahami  penjelasan  ataupun  penerapan mengenai  suatu 
konsep tertentu. Untuk menguji kompetensi siswa, pada bagian akhir bab terdapat dengan 
soal-soal latihan yang berkaitan dengan pokok bahasan pada bab tersebut. 
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                        BAB IBAB I
MENGENAL GAMBAR DIGITALMENGENAL GAMBAR DIGITAL

STANDARD KOMPETENSISTANDARD KOMPETENSI
➢ Menggunakan perangkat lunak pembuat grafis bitmap dan vektor.

KOMPETENSI DASARKOMPETENSI DASAR
➢ Membedakan jenis gambar/grafis bitmap atau raster dengan gambar/grafis vektor.

PETA KONSEPPETA KONSEP
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Pengenalan 
Gambar

Gambar

Digital

Non Digital

Alat Jenis

Kamera

Komputer

Bitmap

Vektor

Kertas

Kanvas

Media atau
alat gambar lainnya



PENGANTAR BABPENGANTAR BAB
i era teknologi informasi dan komunikasi ini, kita mengenal dua jenis gambar, 
gambar biasa (non digital) dan gambar dalam bentuk digital. Gambar non digital 
adalah  sketsa  atau  guratan  alat  gambar  ke  suatu  media  kertas,  kanvas,  dan 

sebagainya  yang berada  di  luar  lingkungan media  digital  (komputer,  kamera).  Gambar 
digital  adalah  gambar  yang  dihasilkan  dari  olah  gambar  di  komputer,  pemotretan 
menggunakan kamera digital, atau media lain yang disimpan dalam bentuk file. Gambar 
digital  terbagi  menjadi  dua  jenis,  yaitu  gambar  jenis  bitmap dan  gambar  jenis  vektor. 
Dalam bab ini, Anda akan belajar lebih dalam tentang gambar digital.

D

A.A. GAMBAR BITMAP  GAMBAR BITMAP 
Gambar bitmap merupakan duplikat atau tiruan persis dari gambar asli dalam bentuk gambar 

digital. Gambar  jenis  ini  tersusun  dari  sejumlah  titik  pixel  (picture  element)/dot/point/titik 
koordinat  yang  ditempatkan  pada  lokasi-lokasi  tertentu  dengan nilai  warna  tersendiri  sehingga 
membentuk pola tertentu di layar komputer. Pola yang terbentuk itulah yang menghasilkan atau 
menimbulkan kesan gambar. Pixel merupakan elemen terkecil citra digital yang dapat dilihat mata. 
Semakin  banyak  jumlah  pixel,  berarti  semakin  tinggi  tingkat  kerapatannya  dan  semakin  halus 
gambar yang terbentuk. Akibatnya, semakin besar pula ukuran file gambar tersebut. Banyaknya 
titik dalam 1 inchi dikenal dengan dpi (dot per inchi). Anda dapat mengenali gambar bitmap dari 
file komputer yang berekstensi .bmp, .jpg, .tfi, .gif, .png, .pix, .pcx, dan sebagainya.

Gambar 1.1 Gambar Bitmap

1.1. Kelebihan gambar bitmapKelebihan gambar bitmap

Gambar bitmap mempunyai kelebihan-kelebihan sebagai berikut.
● Mampu menangkap nuansa warna dan bentuk yang natural.
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● Lebih  cepat  dan  lebih  sesuai  untuk  ditampilkan  ke  layar  monitor,  karena  gambar 
bitmap dapat ditransfer secara langsung dari file ke layar monitor Anda.

2.2. Kekurangan gambar Kekurangan gambar bitmapbitmap

Selain  mempunyai  kelebihan-kelebihan,  gambar  bitmap  juga  mempunyai  beberapa 
kekurangan sebagai berikut.
● Perubahan  ukuran  gambar  (pembesaran  dan  pengecilan)  mempengaruhi  kualitas 

gambar.
● Ukuran file gambar relatif besar.
● Melakukan kompresi  (pemadatan)  pada  gambar,  maka kualitasnya  gambar  tersebut 

akan menurun.

3.3. Program  aplikasi pengolah gambar bitmapProgram  aplikasi pengolah gambar bitmap

Suatu gambar bitmap dapat diolah kembali dengan cara memberikan efek-efek khusus 
pada gambar, memotong gambar, menempelkan gambar bitmap lain, atau menambahkan 
objek lain baik yang berupa teks maupuan objek-objek bidang seperti kotak, lingkaran, 
dan sebagainya. Pengolahan gambar bitmap dapat kita lakukan dengan aplikasi-aplikasi 
yang  dirancang  khusus  untuk  mengolah  gambar,  seperti  Adobe  Photoshop,  Corel 
Photopaint, dan GIMP. Photoshop dan Photopaint merupakan program aplikasi berbayar 
(tidak gratis), namun GIMP adalah program aplikasi yang gratis. Meskipun gratis, gambar 
yang dihasilkan GIMP tidak kalah kualitasnya dengan gambar yang dihasilkan program 
berbayar.

B.B. GAMBAR VEKTOR GAMBAR VEKTOR
Gambar vektor adalah gambar yang tersusun oleh sekumpulan garis, kurva, dan bidang 
tertentu dengan menggunakan  serangkaian  instruksi  yang masing-masing  didefinisikan 
secara matematis. Setiap garis, kurva, dan bidang tertentu tersebut mempunyai properti 
atau atribut masing-masing berupa fill, stroke, dan node. Gambar vektor tidak dipengaruhi 
oleh resolusi gambar atau titik pixel (dpi) seperti pada gambar bitmap.

Gambar 1.2 Contoh gambar vektor
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Gambar 1.3 Salah satu objek awal mula pembuatan gambar vektor

1.1. Kelebihan gambar Kelebihan gambar vektorvektor

Gambar vektor mempunyai kelebihan-kelebihan sebagai berikut.
● Bersifat scalable, artinya kita dapat memperbesar atau memperkecil gambar tanpa mengubah 

kualitasnya.
● Memiliki ukuran file yang kecil, sehingga lebih mudah dan lebih cepat didownload melalui 

Internet.
● Dapat diubah dalam berbagai tampilan tiga dimensi, tentunya dengan menggunakan software 

yang sesuai.
● Mempunyai warna-warna yang solid, cocok untuk bentuk-bentuk gambar sederhana, seperti 

logo, kartun, dan sebagainya.

2.2. KekuranganKekurangan gambar vektor gambar vektor

● Kekurangan gambar  vektor  adalah kurang dapat  menampilkan gambar  dan  gradasi 
secara realitis atau natural.

3.3. Program aplikasi pengolah gambar vektorProgram aplikasi pengolah gambar vektor

Gambar vektor dapat dibuat dengan program aplikasi desain grafis untuk gambar vektor seperti 
CorelDraw,  Macromedia  Freehand,  Macromedia  Flash,  Dia,  dan  Inkscape.  Aplikasi-aplikasi 
tersebut  masing-masing  mempunyai  kelebihan  dan  kekurangan.  Dia  dan  Inkscape  merupakan 
program aplikasi pengolah gambar vektor yang bersifat gratis, namun kemampuannya tidak kalah 
dengan aplikasi berbayar.

C. RANGKUMANC. RANGKUMAN
Gambar  digital  secara  umum terbagi  menjadi  dua  jenis,  yaitu  gambar  bitmap  dan  gambar 

vektor.  Masing-masing  gambar  mempunyai  kelebihan  dan  kekurangan.  Gambar  bitmap  lebih 
bersifat natural, dan memang merupakan duplikat dari kondisi asli alami yang disimpan melalui 
media kamera menjadi file. Bila diperbesar, kualitas gambar bitmap akan menurun dan terkesan 
pecah-pecah  membentuk  titik-titik  kotak  kecil  yang  dikenal  dengan  pixel.  Gambar  vektor 
merupakan gambar yang dibentuk dari awal dengan membuat dan menggabungkan beberapa objek 
garis, kurva, dan bidang tertentu menjadi suatu gambar jadi. Contoh gambar vektor adalah gambar 
kartun.
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D. ISTILAH-ISTILAH PENTINGD. ISTILAH-ISTILAH PENTING

ISTILAH ARTI

 Fill Isi  dari  suatu objek  kurva atau  bidang-bidang tertentu, biasanya  berupa 
warna.

 Natural Warna atau kesan alamiah.

 Node Titik-titik penghubung antar garis pada suatu objek.

 Pixel Picture  element,  bagian  terkecil  dari  gambar  bitmap,  berupa  titik-titik 
penyusun gambar.

 Stroke Objek garis dari suatu gambar.

E. EVALUASIE. EVALUASI
a.  Soal Pilihan Ganda 
Pilihlah jawaban yang paling tepat.

1. File gambar yang dihasilkan dari kamera termasuk gambar jenis ....
a. non digital
b. bitmap
c. vektor
d. pixel
e. scalable

2. Gambar kartun termasuk gambar jenis ....
a. non digital
b. bitmap
c. vektor
d. pixel
e. scalable

3. Program aplikasi untuk mengolah gambar bitmap yang dapat digunakan secara gratis 
adalah ....
a. Adobe Photoshop
b. Corel Photopaint
c. Gimp
d. Dia
e. Inkscape

4. Program  aplikasi  untuk  membuat  gambar  vektor  yang  dapat  digunakan  secara 
adalah ....
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a. CorelDraw
b. Gimp
c. Macromedia Flash
d. Adobe Photoshop
e. Inkscape

5. Titik-titik  yang  merupakan  bagian  terkecil  dari  gambar  bitmap  dikenal  dengan 
istilah ....
a. pixel
b. scalable
c. node
d. stroke
e. fill

6. Kesan alami yang didapatkan dari suatu objek, dikenal dengan istilah ....
a. node
b. fill
c. pixel
d. natural
e. stroke

7. Gambar yang bersifat  scalable,  sehingga kualitasnya tetap bila diperbesar maupun 
diperkecil adalah gambar jenis ....
a. bitmap
b. vector
c. natural
d. non digital
e. lukisan

8. Gambar kartun  atau  vektor  merupakan gabungan dari  beberapa  objek  berikut  ini, 
kecuali ....
a. garis
b. kurva
c. kotak
d. lingkaran
e. foto

9. Ukuran file gambar vektor bila dibandingkan dengan gambar bitmap adalah  ....
a. lebih kecil
b. sama
c. lebih besar
d. lebih lebar
e. fleksibel

10. Gambar manual dapat diubah menjadi gambar vektor, dengan cara ....
a. memotret
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b. membuat dengan Inkscape
c. mengolah dengan Gimp
d. scanning
e. membuat pada kanvas

b. Soal Teori 
Jawablah pertanyaan-pertanyaan berikut ini. 

1. Jelaskan pengertian gambar digital!
2. Tuliskan perbedaan gambar non digital dengan gambar digital!
3. Tuliskan kelebihan dan kekurangan gambar bitmap!
4. Tuliskan kelebihan dan kekurangan gambar vektor!
5. Jelaskan pengertian gambar kartun!

c. Soal Praktik
Kerjakan soal praktik berikut ini.

1. Buatlah suatu sketsa yang bisa mengenalkan gambar bitmap dan gambar vektor, serta bisa 
menjelaskan perbedaan kedua gambar tersebut.  Buat pada selembar karton atau steroform 
lengkap dengan gambar dan keterangannya.

2. Buat formatnya minimal dalam ukuran B3, seperti gambar berikut ini.
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                        BAB IIBAB II
MENGENAL INKSCAPEMENGENAL INKSCAPE

STANDARD KOMPETENSISTANDARD KOMPETENSI
➢ Menggunakan perangkat lunak pembuat grafis bitmap dan vektor.

KOMPETENSI KOMPETENSI DASARDASAR
➢ Menunjukkan menu dan ikon yang terdapat dalam perangkat lunak pembuat grafis 

vektor.

PETA PETA KONSEPKONSEP
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PENGANTAR BABPENGANTAR BAB
nkscape merupakan program aplikasi  desain  grafis  untuk membuat  dan  mengolah 
gambar vektor. Inkscape bersifat free (gratis) dan multiplatform (dapat berjalan pada 
berbagai sistem operasi). Kemampuan Inkscape dalam membuat gambar vektor tidak 

kalah dengan aplikasi grafis yang berbayar seperti CorelDraw dan  Freehand. Saat Anda 
meng-install sistem  operasi  Linux,  Inkscape  merupakan  salah  satu  aplikasi  yang  ikut 
disertakan. Inkscape dapat Anda download di www.inkscape.org. Pada bab ini, Anda akan 
mempelajari  cara  membuka  program  Inkscape  dan  mengenal  menu  dan  ikon  pada 
Inkscape.

I

A.A. MENJALANKAN APLIKASI INKSCAPE  MENJALANKAN APLIKASI INKSCAPE 
Untuk  menjalankan  aplikasi  Inkscape,  Anda  dapat  mengklik  menu  Applications  pada 
menu utama Linux. Langkah-langkahnya adalah seperti berikut.

1.Klik Aplications.
2.Pilih Grafis (atau Graphics).
3.Klik ikon Inkscape Vector Graphics Editor.

Gambar 2.1 Menjalankan Inkscape dari menu Application

2222        MENGENAL INKSCAPEMENGENAL INKSCAPE        

http://www.inkscape.org/


B.B. MENU DAN IKON PADA INKSCAPE MENU DAN IKON PADA INKSCAPE
Setelah  Anda  menjalankan  Inkscape,  Anda  akan  melihat  tampilan  jendela  Inkscape.  Pada 

tampilan  inilah  Anda  akan  melakukan  segala  kegiatan  desain.  Gambar  2.2  memperlihatkan 
tampilan jendela Inkscape dan bagian-bagiannya.

Gambar 2.2 Jendela Inkscape dan bagian-bagiannya

Penjelasan mengenai bagian-bagian dalam jendela Inkscape adalah sebagai berikut.

1.1. Menu BarMenu Bar

Menu bar berisi menu-menu untuk mengelola dokumen secara umum, seperti File → Save 
untuk menyimpan dokumen dan File → Print untuk mencetak dokumen.

Gambar 2.3 Menu Bar
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2.2. CommandsCommands Bar Bar

Commands bar berisi ikon-ikon yang merupakan shortcut untuk perintah-perintah pokok 
seperti print, open, save, dan sebagainya. 

Gambar 2.4 Command Bar

3.3. Tool Controls Tool Controls BarBar

Tool Controls  Bar  berisi  ikon-ikon untuk memodifikasi  objek,  misalnya  memutar  dan 
mengatur ukuran atau tata letak urutan objek.

Gambar 2.5 Tool Control Bar

4.4. RulerRuler

Ruler atau penggaris berfungsi untuk melihat dan memperkirakan ukuran gambar dalam 
satuan pixels.

5.5. ScrollbarScrollbar

Scrollbars berguna untuk menggulung layar dokumen atas-bawah dan kiri-kanan.

6.6. LembarLembar Kerja Kerja

Lembar kerja merupakan tempat untuk meletakkan objek yang Anda buat.

7.7. PalettePalette

Palette  berisi  warna-warna  yang  dapat  Anda  gunakan  untuk  mewarnai  objek.  Bila  Anda 
mengklik objek,  kemudian  mengklik warna yang Anda inginkan di  Palette,  maka warna objek 
tersebut akan berubah.

Gambar 2.6 Pallete
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8.8. Status BarStatus Bar

Status bar dapat Anda gunakan untuk melihat status dokumen Inkscape yang sedang Anda 
buat. Pada Status bar tercantum informasi-informasi seperti warna objek dan posisi objek 
bila  dilihat  pada ukuran di  ruler. Status  bar  dapat  juga Anda gunakan untuk  zooming 
(memperbesar-memperkecil) tampilan dokumen.

Gambar 2.7 Status bar

9.9. ToolboxToolbox

Toolbox berisi tool-tool yang sangat berguna dalam proses perencanaan dan perancangan suatu 
desain. Contoh tool yang terdapat dalam Toolbox adalah Select and transform, Tweak objects, dan 
Bezier curves and straight line, dan Zoom.

Gambar 2.8 Toolbox

    MENGENAL INKSCAPEMENGENAL INKSCAPE    2525



TOOL FUNGSI

Select and transform Memilih,  mengubah  ukuran,  memutar,  menggeser  dan  me-refleksi 
objek.

Edit paths Mengubah posisi titik node suatu objek hingga objek berubah bentuk.

Tweak object Mengubah bentuk objek dengan menarik bagian isi (fill) objek.

Zoom Memperbesar atau memperkecil ukuran tampilan dokumen.

Rectangle and Square Menggambar bentuk objek kotak.

3D Boxes Menggambar bentuk objek kotak 3 dimensi.

Circle, ellipses, and arcs Menggambar bentuk objek lingkaran, setengah lingkaran.

Stars and polygons Menggambar bentuk objek bintang dan persegi banyak.

Spirals Menggambar bentuk objek spiral.

Freehand lines Menggambar bentuk objek bebas seperti menggambar dengan pensil.

Bezier  curves  and 
straight lines

Menggambar bentuk objek dengan garis-garis yang saling terhubung.

Calligraphic  or  brush 
strokes

Menggambar bentuk objek dengan efek highlight.

Fill bounded areas Memberikan warna ke isi objek.

Text Membuat tulisan.

Diagram connectors Membuat garis penghubung dari satu objek ke objek lain.

Gradients Memberikan efek warna gradasi (perpaduan warna) ke isi objek.

Pick colors from image Mengambil  warna-warna  tertentu  dari  suatu  gambar  yang  nantinya 
digunakan untuk memberi warna ke isi objek.

Tabel 2.1 Tool-tool dalam Toolbox dan fungsinya

Bagian-bagian dari Inkscape dapat Anda tampilkan maupun Anda sembunyikan melalui menu View 
→ Show/Hide. Agar lebih jelas, perhatikan Gambar 2.9 berikut ini.
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Gambar 2.9 Show/Hide Tools di Inkscape

C. MENYIMPAN DOKUMEN INKSCAPE C. MENYIMPAN DOKUMEN INKSCAPE 
Dokumen  yang  Anda  buat  dengan  Inkscape  akan  disimpan  dalam  bentuk  file  yang 
berekstensi svg (nama file.svg). Untuk menyimpan dokumen, Anda dapat menggunakan 
menu  File → Save  As atau  ikon  Save pada  Commands  bar  (Gambar  2.9).  Program 
Inkscape dapat Anda tutup dengan klik menu  File → Quit atau menekan Ctrl + Q pada 
keyboard. 

D. RANGKUMAND. RANGKUMAN
Inkscape  merupakan  salah  satu  program  aplikasi  desain  grafis  untuk  menggambar 
berbagai objek vektor. Tool-tool yang terdapat pada Inkscape secara umum sama dengan 
tool-tool  pada  program aplikasi  desain  grafis  lainnya.  Inkscape  bebas  digunakan  dan 
didownload melalui situs  http://www.inkscape.org/download/. Aplikasi Inkscape biasanya 
disertakan dalam paket-paket sistem operasi Linux.
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E. ISTILAH-ISTILAH PENTINGE. ISTILAH-ISTILAH PENTING

ISTILAH ARTI

 Free software Perangkat lunak yang gratis (bebas) untuk digunakan.

 Multiplatform Dapat berjalan pada beragam sistem operasi.

 Node Titik-titik penghubung antar garis di suatu objek.

 Refleksi Membentuk objek yang bertolak belakang seperti efek cermin.

 Tool Alat yang digunakan untuk membuat dan memodifikasi objek.

 Download Mengambil file dari Internet.

F. EVALUASIF. EVALUASI
a. Soal Pilihan Ganda
Pilihlah jawaban yang paling tepat.

1. Inkscape merupakan suatu program aplikasi untuk ....
a. pemrograman
b. desain grafis
c. presentasi
d. internet
e. multimedia

2. Free software mempunyai pengertian ....
a. software berbayar
b. software gratis
c. software demo
d. software bajakan
e. Licency

3. Inkscape digunakan untuk membuat gambar berjenis ....
a. vektor
b. bitmap
c. mp3
d. pdf
e. 3gp

4. Bagian  yang  digunakan  untuk   mengatur  zoom (memperbesar-memperkecil) 
tampilan dokumen Inkscape adalah ....
a. menu bar
b. commands bar
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c. tool controls bar
d. toolbox
e. status bar

5. Bagian dari  Inkscape yang digunakan untuk melihat properties dan status suatu 
objek adalah ....
a. status bar
b. commands bar
c. tool controls bar
d. toolbox
e. menu bar

6. Bagian  dari  Inkscape  yang  digunakan  untuk  membuat  suatu  objek  atau 
perancangan desain adalah ....
a. menu bar
b. tool controls bar
c. status bar
d. commands bar
e. toolbox

7. Ekstensi file dari Inkscape adalah ....
a. cdr
b. svg
c. pdf
d. bmp
e. odt

8. Sistem operasi yang sudah menyertakan Inkscape kedalamnya adalah ....
a. Windows
b. Linux
c. Machintos
d. FreeBSD
e. Symbian

9. Pada Inkscape, ikon yang digunakan untuk menyimpan file terdapat di ....
a. tool controls bar
b. commands bar
c. toolbox
d. status bar
e. scrollbars

10. Keluar dari program Inkscape, shortcut yang digunakan pada keyboard adalah ....
a. Ctrl E
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b. Ctrl Q
c. Alt E
d. Alt Q
e. Ctrl S

b. Soal Teori
Jawablah pertanyaan-pertanyaan berikut ini.

1. Apa yang Anda ketahui tentang Inkscape dan desain grafis?
2. Tuliskan cara menampilkan program Inkscape!
3. Bagaimana cara menampilkan dan menyembunyikan toolbox Inkscape?
4. Jelaskan fungsi Toolbox!
5. Jelaskan cara memperoleh Inkscape!

c. Soal Praktik
Kerjakan soal praktik berikut ini.

1. Bukalah program Inkscape.
2. Buatlah gambar seperti berikut menggunakan ikon Rectangle and Square.

3. Beri warna yang menarik dan bagus.
4. Simpan di folder masing-masing pada Documents.
5. Simpan dengan nama file praktek01_nama_kelas.
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                        BAB IIIBAB III
MEMBUAT OBJEK DENGAN MENU DAN IKON PADAMEMBUAT OBJEK DENGAN MENU DAN IKON PADA  
INKSCAPEINKSCAPE

STANDARD KOMPETENSISTANDARD KOMPETENSI
➢ Menggunakan perangkat lunak pembuat grafis bitmap dan vektor.

KOMPETENSIKOMPETENSI DASAR DASAR
➢ Menggunakan menu dan ikon  yang  terdapat dalam perangkat lunak pembuat grafis 

vektor.

PETA PETA KONSEPKONSEP
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PENGANTAR BABPENGANTAR BAB
erpaduan  antara  objek  yang  bagus  dan  warna  yang  sesuai  akan  menghasilkan 
gambar vektor yang menarik.   Karena itu, gambar vektor sering digunakan untuk 
membuat  logo.  Logo  yang  menarik  berasal  dari  perpaduan  antara  objek-objek 

seperti kotak, lingkaran, serta garis dan warna tertentu yang tersusun dengan baik. Pada 
bab ini,  Anda akan membuat  suatu objek dan memadukannya dengan objek-objek lain 
hingga menjadi gambar vektor yang sederhana, namun bagus dan menarik.

P
A. MEMBUAT OBJEK DENGAN IKON-IKON DI TOOLBOXA. MEMBUAT OBJEK DENGAN IKON-IKON DI TOOLBOX
Toolbox digunakan untuk membuat suatu objek. Bentuk-bentuk objek yang dapat Anda 
buat  menggunakan  ikon-ikon  yang  terdapat  pada  Toolbox  antara  lain  kotak  (dengan 
menggunakan ikon Rectangle and Square), lingkaran (menggunakan ikon Circles), elips 
(menggunakan ikon Ellipses), dan garis  lengkung (menggunakan ikon Arcs).  Tool-tool 
penting yang terdapat pada Toolbox adalah sebagai berikut. 

1.1. Select and Transform ObjectsSelect and Transform Objects

Tool  ini  dapat  Anda  gunakan  untuk  memilih  objek,  memindahkan  objek, 
memperkecil/memperbesar objek, memutar objek, memberi warna objek. Tool ini dapat 
diaktifkan dengan mengklik ikon Select and Transform Objects atau menekan F1 pada 
keyboard.

Gambar 3.1 Mengaktifkan select dan transform object
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Gambar 3.2 mengubah ukuran obyek

Gambar 3.3 memutar dan memiringkan obyek

2.2. Edit Paths by NodesEdit Paths by Nodes

Anda dapat menggunakan tool ini untuk mengubah sudut objek, memindahkan posisi titik 
penghubung antar garis pada objek, dan mengubah garis lurus objek menjadi garis lengkung.

Gambar 3.4 Mengubah sudut obyek

MEMBUAT OBJEK DENGAN MENU DAN IKON PADA INKSCAPEMEMBUAT OBJEK DENGAN MENU DAN IKON PADA INKSCAPE    3333



Gambar 3.5 Mengubah bentuk obyek

Gambar 3.6 Mengubah llingkaran menjadi pie setengah lingkaran

Edit Path by Nodes dapat juga Anda aktifkan dengan menekan tombol F2 pada keyboard. 
Objek  berupa  kotak,  lingkaran,  dan  objek  banyak  sisi  dapat  diubah  ke  bentuk  bebas 
menggunakan Edit path. Akan tetapi, sebelumnya objek tersebut harus diubah ke bentuk 
path (object to path) melalui menu Path → Object to Path atau menekan Shift + Ctrl + C 
pada  keyboard.  Setelah  langkah  tersebut  Anda  lakukan,  barulah  objek  tersebut  dapat 
diubah seperti yang tampak pada Gambar 3.5.

3.3. Rectangle and SquareRectangle and Square

Tool  ini  dapat  Anda gunakan untuk  membuat  objek  bujursangkar  atau  persegipanjang. 
Untuk membuat bujursangkar, secara bersamaan Anda perlu menekan tombol CTRL pada 
keyboard.
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Gambar 3.7 membuat rectangle dan bujur sangkar

4.4. 3D 3D BoxesBoxes

3D Boxes berguna untuk membuat objek kotak 3 dimensi.  Untuk mengaktifkan melalui 
keyboard, tekan tombol Shift + F4.

Gambar 3.8 membuat kotak 3 dimensi 

5.5. Circles, Ellipses, and ArcsCircles, Ellipses, and Arcs

Tool ini  dapat  Anda gunakan untuk membuat  lingkaran,  elips,  pie,  dan arc.  Lingkaran 
sempurna dapat Anda buat jika Anda menekan tool ini sambil menekan tombol CTRL pada 
keyboard. Untuk membuat objek pie atau arc, Anda dapat menggunakan bantuan tool Edit 
path yang telah kita bahas sebelumnya. Tool Circles, Ellipses, and Arc juga dapat Anda 
aktifkan melalui keyboard dengan menekan tombol F5.
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Gambar 3.9 Membuat elips dan lingkaran

6.6. Stars and PolygonsStars and Polygons

Tool ini dapat Anda gunakan untuk membuat objek bintang atau objek dengan banyak sisi. 
Untuk mengaktifkannya melalui keyboard, tekan tombol Shift + 8. Bentuk bintang dan segi 
banyak dapat Anda buat dengan mengklik ikon pada toolbar yang otomatis muncul saat 
Anda mengaktifkan tool Stars and Polygon.

Gambar 3.10 membuat star dan polygon

7.7. SpiralsSpirals

Tool Spirals berguna untuk membuat objek garis spiral atau gelombang. Tool ini dapat Anda 
aktifkan melalui keyboard dengan menekan tombol F9.
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Gambar 3.11 Membuat spiral

8.8. Freehand Freehand LinesLines

Anda dapat menggunakan tool Freehand Lines untuk membuat objek bebas seperti Anda 
menggambar  menggunakan  pensil  pada  selembar  kertas.  Freehand  Lines  dapat  Anda 
aktifkan melalui keyboard dengan menekan tombol F6.

Gambar 3.12 Memuat obyek bebas

9.9. Bezier Curves and Bezier Curves and StraightStraight Lines Lines

Bezier  Curves  and  Straight  Lines  merupakan  tool  untuk  membuat  suatu  objek  bebas 
dengan sebelumnya menentukan titik-titik pertemuan antar garis pada suatu objek yang 
akan dibuat. Tool ini sangat bermanfaat untuk menggambarkan sketsa yang Anda buat di 
atas kertas dan Anda pindahkan ke komputer dengan scanner. Dengan Bezier Curves and 
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Straight Lines dan bantuan tool Edit Path Anda dapat membuat tokoh kartun.

Gambar 3.13 Membuat obyek bebas dengan titik-titik node

10.10. Calligraphic or Brush Calligraphic or Brush StrokesStrokes

Tool ini dapat Anda gunakan jika Anda ingin membuat suatu efek tulisan kaligrafi atau 
kuas atau efek highlight. Untuk mengaktifkan tool Calligraphic or Brush Strokes, Anda 
cukup menekan tombol CTRL + F6 pada keyboard.

Gambar 3.14 Membuat kaligrafi atau stabilo
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11.11. TextText

Text tool Anda perlukan saat akan memasukkan tulisan ke dalam proyek Anda. Tool ini 
dapat Anda aktifkan dengan menekan tombol F8 pada keyboard.

Gambar 3.15 Membuat tulisan

Untuk memberi warna isi dan warna garis pada suatu objek, Anda dapat menggunakan 
Pallete dan Status bar. Untuk mewarnai isi objek, lakukan klik kiri pada warna yang Anda 
inginkan. Cara lainnya adalah dengan klik kanan pada Pallete, lalu memilih bagian objek 
yang  akan  diberi  warna,  yaitu  isi  (fill)  atau  garis  (stroke)  dengan  klik  kiri  mouse. 
Perhatikan Gambar 3.16 agar semakin jelas.

Gambar 3.16 Mewarnai Obyek

Saat  Anda  bekerja  pada  Inkscape,  adakalanya  tampilan  Inkscape  terlihat  kecil.  Untuk 
memperbesar tampilan tersebut, gunakan Zoom dari Toolbox atau tekan tombol  Z pada 
keyboard, kemudian klik kiri pada objek. Bila Anda ingin mengecilkan kembali tampilan, 
tekan tombol  Shift dan tahan,  kemudian klik kiri  pada objek sampai  Anda rasa cukup 
ukuran tampilannya.
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B. MODIFIKASI OBJEK PADA INKSCAPEB. MODIFIKASI OBJEK PADA INKSCAPE
Inkscape juga menyediakan fasilitas-fasilitas agar Anda dapat membuat lebih banyak variasi 

dalam proyek gambar vektor yang Anda buat. Fasilitas tersebut terletak pada menu Object, Path, 
dan Text. Dalam pembuatan objek, terkadang posisi objek saling bertumpuk di atas dan bawah. 
Anda dapat memindahkan posisi objek dengan cara menekan tombol pada keyboard. Tombol PgUp 
untuk memindahkan posisi objek ke atas atau ke depan, dan tombol PgDn untuk memindahkan 
posisi objek ke bawah atau ke belakang.

Gambar 3.17 Posisi Obyek

1.1. Menu Menu ObjectObject

Pada  menu  ini,  dapat  Anda  temukan  beberapa  fungsi  untuk  objek.  Fungsi  yang  umum 
digunakan adalah Fill  and Stroke untuk mengubah warna pada isi  dan garis  objek,  Group dan 
UnGroup untuk menggabungkan beberapa objek dan memisahkan objek yang telah digabungkan, 
Rotate untuk memutar objek, dan Flip untuk membalik objek.  

Gambar 3.18 rotate object
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Gambar 3.19 Flip Obyek

Selain itu, masih ada fungsi Transform untuk mengerjakan hal-hal yang berkaitan dengan 
transformasi  objek  seperti  perpindahan  (Move),  ukuran  (Scale),  perputaran  (Rotate), 
tingkat kemiringan (Skew). Transform dapat dijalankan, bila objek sudah diseleksi. Menu 
ini  dapat  Anda aktifkan dengan menekan kombinasi  tombol  Shift  + CTRL + M pada 
keyboard. 

Gambar 3.20 transform move
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Gambar 3.21 Transform scale

Gambar 3.22 Transform rotate
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Gambar 3.23 Transform skew

2.2. Menu Menu PathPath

Menu Path dapat Anda gunakan untuk memodifikasi  satu atau beberapa objek menjadi 
suatu  objek  baru.  Hampir  semua  bagian  dari  menu  Path  sangat  berguna  untuk 
memodifikasi gambar. Gambar 3.24 menunjukkan bagian-bagian menu Path yang umum 
digunakan. 

Gambar 3.24 menu path
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1. Bagian 1

Bagian ini  berguna untuk mengubah properti  objek sehingga objek tersebut  lebih 
mudah diubah ke bentuk objek lain menggunakan tool Edit Path pada toolbox. Objek 
yang  diubah  adalah  objek  yang  sudah  baku,  seperti  kotak,  lingkaran,  bintang, 
polygon. Pada bagian ini ada 3 submenu yang dapat Anda gunakan, yaitu Object to 
Path (objek yang diubah ke path), Stroke to Path (garis yang diubah ke path), dan 
Trace Bitmap (mengubah gambar bitmap yang diimpor ke dalam Inkscape menjadi 
gambar vektor).

Gambar 3.25 Hasil Object to path yang diubah dengan edit path

Gambar 3.26 Hasil Stroke to path, fill hilang dan gambar berubah setelah diubah dengan 
edit path
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Gambar 3.27 Hasil Trace Bitmap, Gambar bitmap yang diubah ke vektor kemudian 
diubah dengan edit path

2. Bagian 2

Bagian ini dapat Anda gunakan untuk membuat objek baru dari perpaduan beberapa 
objek. Sub menu yang terdapat di bagian ini antara lain:
● Union

Sub menu ini berguna untuk menggabungkan beberapa objek menjadi objek baru. 
Objek-objek tersebut disusun dengan posisi saling bertumpuk (Gambar 3.28).

Gambar 3.28 Hasil Union, 2 objek yang diseleksi
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● Difference
Pada sub menu ini, posisi objek yang di atas atau di depan memotong objek yang 
ada di bawahnya seperti tampak pada Gambar 3.29.

Gambar 3.29 Hasil Difference, Lingkaran memotong persegi

● Intersection
Sub menu ini dapat Anda gunakan untuk mengambil objek hasil perpotongan dua 
objek atau lebih seperti yang diperlihatkan pada Gambar 3.10.

Gambar 3.30 Hasil Intersection

● Exclusion
Sub  menu  ini  dapat  Anda  gunakan  untuk  menghasilkan  objek  yang  bertolak 
belakang dengan objek hasil sub menu Intersection. Objek baru terbentuk dengan 
membuang perpotongan kedua objek. Perhatikan Gambar 3.31 agar lebih jelas.

Gambar 3.31 Hasil Exclusion

● Division
Submenu ini berguna untuk mengambil hasil pemotongan objek di posisi bawah 
oleh objek yang berada di atasnya seperti yang terlihat pada Gambar 3.32.
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Gambar 3.32 Hasil Division

● Cut path
Submenu ini dapat Anda gunakan untuk mengambil garis atau stroke dari objek 
yang dipotong oleh objek di atasnya. Hasilnya hanya berupa garis karena isi atau 
fill akan dihilangkan (perhatikan Gambar 3.33).

Gambar 3.33 Hasil Cut path

3. Bagian 3

Bagian ini  mempunyai fungsi  yang sama dengan bagian 2,  namun kegunaan dan 
hasil sub menu yang ada di dalamnya berbeda. Sub menu yang terdapat di bagian 3 
adalah sebagai berikut. 
● Combine

Submenu  ini  berguna  untuk  menggabungkan  beberapa  objek,  lalu  membuang 
perpotongan antar objek dan membentuk objek baru. Pada contoh di bawah ini, 
awalnya dibuat sebuah elip, kemudian diputar menggunakan transform sebesar 15 
derajat,  kemudian  diduplicate,  diputar  15  derajat,  demikian  seterusnya  hingga 
dihasilkan pola yang menarik, di combine. 
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Gambar 3.34 Elips yang diputar 15 derajat, kemudian di duplicate secukupnya dan di 
combine

● Break Apart
Sub menu ini dapat Anda gunakan untuk mengembalikan objek-objek yang telah 
Anda combine.

Gambar 3.35 Objek-objek yang kembali didapat setelah dicombine

4. Menu Text

Menu ini berguna untuk mengubah fornat teks dan meletakkan teks ke path suatu 
objek atau melepas teks dari path. Sub menu yang biasa digunakan adalah Text and 
Font, Put on Path, dan Remove from Path.
● Text and Font

Sub menu ini dapat Anda gunakan untuk mengubah jenis huruf, ukuran huruf, dan 
properti huruf (tebal, miring), serta fasilitas penulisan paragraf seperti layout dan 
line spacing.
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Gambar 3.36 Text and Font

● Put on Path
Sub menu ini berfungsi untuk menempatkan teks pada garis suatu objek, misalnya 
pada lingkaran. Mula-mula, teks dan objek harus Anda seleksi terlebih dahulu. 
Kemudian, klik menu Text → Put on Path dan putar objek hingga tulisan berada 
pada  posisi  yang tepat.  Perhatikan  Gambar 3.37 yang menjelaskan fungsi  sub 
menu ini.

Gambar 3.37 Proses teks Put on Path

Tulisan text to path dapat dilepaskan dari lingkaran, dengan cara seleksi kedua 
objek yang menyatu  setelah  proses  put  on  path,  kemudian  klik  menu Edit  → 
Duplicate dan hapus lingkaran tersebut.

● Remove from Path
Sub menu ini berguna untuk melepaskan teks dari objek setelah proses put on 
path.
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C. MENGATUR DOKUMENC. MENGATUR DOKUMEN
Sebelum membuat dokumen baru, sebaiknya Anda mempersiapkan ukuran dokumen dan 
orientasi halaman (potrait atau landscape) agar dokumen tersebut mudah dicetak. Untuk 
mengatur ukuran dokumen, Anda dapat menggunakan menu File → Document Properties 
(Gambar 3.38).

Gambar 3.38 Document Properties

D. RANGKUMAND. RANGKUMAN
Menu dan ikon pada  Inkscape menyediakan semua fasilitas  untuk proses menggambar 
maupun mengubah (mengedit) gambar. Menu yang umum digunakan dalam pengolahan 
gambar  adalah  Object,  Path,  dan  Text.  Tool  yang  umum  digunakan  dalam  proses 
pengolahan  gambar  adalah  Toolbox.  Untuk  membuat  gambar  vektor  yang  bagus  dan 
menarik,  diperlukan  daya  imajinasi,  kreatifitas,  dan  keahlian  menggunakan  program 
aplikasi. Keahlian untuk menggunakan Inkscape dapat Anda peroleh dengan terus belajar 
membuat gambar, dan mencari sumber informasi-informasi dari buku atau Internet.
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E. ISTILAH-ISTILAH PENTINGE. ISTILAH-ISTILAH PENTING

 ISTILAH ARTI

 Flip Membalik objek.

 Path Garis objek.

 Put Meletakkan objek.

 Select Memilih objek dengan menggunakan select and transform objek.

 Transform Memindahkan objek.

F. EVALUASIF. EVALUASI
a. Soal Pilihan Ganda 
Pilihlah jawaban yang paling tepat.

1. Bagian dari  Inkscape yang berguna untuk membentuk atau mengubah suatu objek 
adalah ....

 a. Menu bar
 b. Status bar
 c. Pallete
 d. Toolbox
 e. Rulers

2. Menu untuk mengatur layout dokumen adalah ....
a. File
b. Edit
c. View
d. Layer
e. Object

3. Bagian dari Toolbox yang dapat kita gunakan untuk memilih dan memindahkan objek 
adalah ....

a. Select and Transform Object
b. Edit Path
c. Zoom in or out
d. Draw Freehand Lines
e. 3D Boxes

4. Suatu objek mempunyai bagian yang dapat diubah menjadi objek bentuk lain. Bagian 
tersebut adalah ....

 a. fill
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 b. stroke
 c. stars and polygons
 d. spirals
 e. palllete

5. Toolbox yang berguna untuk mengubah (edit) objek adalah ....
 a. Select and Transform Object
 b. Edit Path
 c. Zoom in or out
 d. Draw Freehand Lines
 e. 3D Boxes

6. Pallete berguna untuk ....
 a. mengubah objek
 b. memindahkan objek
 c. memutar objek
 d. mengubah ukuran objek
 e. mewarnai objek

7. Ikon untuk menyimpan objek, terdapat pada toolbar ....
 a. Commands 
 b. Tool Controls 
 c. Toolbox
 d. Pallete
 e. Status bar

8. Toolbox  yang  berguna  untuk  membuat  suatu  objek  bebas  dengan  sebelumnya 
menentukan titik-titik pertemuan antar garis pada suatu objek yang akan dibuat adalah 
....

 a. Edit Path
 b. Draw Freehand Lines
 c. Bezier Curves and Straight Lines
 d. Zoom in or out
 e. Fll Bounded Areas

9. Menu .... digunakan untuk mengubah tulisan atau huruf.
 a. File
 b. Edit
 c. Object
 d. Path
 e. Text
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10. Sub menu yang berguna untuk mengubah objek tertentu, misalnya mengubah kotak 
menjadi bentuk objek bebas menggunakan Edit Path adalah....

 a. Transform
 b. Object to Path
 c. Union
 d. Combine
 e. Put on Path

b. Soal Teori 
Kerjakan pertanyaan-pertanyaan berikut ini.

1. Tuliskan cara menentukan layout dokumen pada Inkscape!
2. Sebutkan fungsi-fungsi Toolbox!
3. Bagaimana cara memberikan warna pada objek?
4. Apakah fungsi dari submenu transform di Inkscape?
5. Tuliskan cara menyimpan dokumen Inscape!

c. Soal Praktik 
Kerjakan soal praktik berikut ini.

1. Bukalah program Inkscape.
2. Buatlah objek bebas yang merupakan perpaduan dari beberapa objek.
3. Berilah warna yang menarik.
4. Simpan di folder Documents dengan nama praktek03_nama_kelas.
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                        BAB IVBAB IV
BERKREASI DENGAN INKSCAPEBERKREASI DENGAN INKSCAPE

STANDARD KOMPETENSISTANDARD KOMPETENSI
➢ Menggunakan perangkat lunak pembuat grafis bitmap dan vektor.

KOMPETENSIKOMPETENSI DASAR DASAR
➢ Membuat dan mengubah gambar vektor .

PETA PETA KONSEPKONSEP
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PENGANTAR BABPENGANTAR BAB
nkscape dapat  kita gunakan untuk menghasilkan berbagai  gambar dan objek yang 
menarik.  Selain  dipengaruhi  oleh  fasilitas-fasilitas  pengolahan  gambar  yang 
disediakan  Inkscape,  kemampuan  menghasilkan  gambar  yang  menarik  juga 

ditentukan oleh kemampuan kita  menggunkan berbagai  fasilitas tersebut.  Pada bab ini, 
Anda akan mempelajari  cara-cara untuk mengolah objek hingga menjadi  gambar  yang 
menarik, misalnya stempel, logo, dan gambar mobil. 

I
A.  MEMBUAT STEMPEL INKSCAPE A.  MEMBUAT STEMPEL INKSCAPE 
Sebagai latihan pertama, Anda akan mempelajari pembuatan stempel Inkscape. Jika Anda 
mengembangkan  kemampuan  ini  dan  banyak  berlatih,  Anda  dapat  menggunakannya 
sebagai sarana berwirausaha. Berikut langkah-langkah untuk membuat stempel.

1. Siapkan dokumen dengan ukuran  B8 dengan orientasi  Potrait  dari  menu File  → 
Document Properties.

Gambar 4.1 Pengaturan dokumen

2. Buat tulisan Inkscape dan ubah jenis dan ukuran huruf dari menu Text.

Gambar 4.2 Mengubah tulisan Inkscape
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3. Buat tulisan V E K T O R dan ubah jenis huruf, dan ukurannya.

Gambar 4.3 Mengubah tulisan V E K T O R

4. Buat lingkaran sempurna seperti pada Gambar 4.4.

Gambar 4.4 Lingkaran sempurna

5. Seleksi tulisan VEKTOR dan lingkaran, kemudian klik menu Text  → Put on Path, 
kemudian putar lingkaran sehingga menjadi seperti Gambar 4.5.

Gambar 4.5 Tulisan Put on Path
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6. Klik kanan lingkaran, klik Fill and Stroke.

Gambar 4.6 Sub menu Fill and Stroke

7. Klik bagian X atau No paint pada Fill dan Stroke (perhatikan Gambar 5.7).

Gambar 4.7 Menghilangkan garis dan isi objek

8. Buat suatu objek dengan menggunakan Bezier Curves and Straight Lines, lalu ubah 
dengan Edit Path, seperti gambar berikut ini.

Gambar 4.8 objek pertama

5858        BERKREASI DENGAN INKSCAPEBERKREASI DENGAN INKSCAPE  



9. Beri warna objek, kemudian pertebal garis objek dengan cara klik kanan klik Fill and 
Stroke, kemudian klik bagian Stroke style, ubah Width menjadi 7. 

Gambar 4.9 Mengatur ketebalan garis

10. Buat objek kedua dengan menggunakan Bezier Curves and Straight Lines, dan beri 
warna putih, seperti gambar berikut ini.

Gambar 4.10 Objek kedua

11. Buat  objek  ketiga  dengan  menggunakan  Bezier  Curves  and  Straight  Lines,  beri 
warna, dan ubah dengan Edit Path menjadi Gambar 4.11.

Gambar 4.11 Objek ketiga

12. Buat objek keempat  dengan menggunakan freehand lines. Sorot objek ketiga dan 
keempat, kemudian klik menu Path → Diferrence seperti tampak pada Gambar 4.12.
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Gambar 4.12 Objek keempat

13. Aturlah semua posisi objek dan beri kotak seperti Gambar 4.13.

Gambar 4.13 Stempel Inkscape

14. Simpan dengan nama file praktikum01_nama_kelas.

B. MEMBUAT LOGO GNOME SUMMITB. MEMBUAT LOGO GNOME SUMMIT
Pada latihan kedua ini, Anda akan belajar cara membuat suatu logo, dalam hal ini logo 
GNOME SUMMIT. Anda dapat  mengembangkannya menurut  kreativitas Anda sendiri. 
Berikut ini langkah-langkah untuk membuat logo GNOME SUMMIT.

1. Siapkan dokumen dengan ukuran A4 dan orientasi Landscape.

Gambar 4.14 Pengaturan dokumen
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2. Buat kotak dengan sudut tumpul, beri warna hijau muda.

Gambar 4.15 Membuat background log

3. Buat  tulisan  GNOME  dan  ubah  format  hurufnya  seperti  gambar  berikut  ini, 
kemudian beri warna putih.

Gambar 4.16 Membuat tulisan

4. Buat tulisan “asia summit” dan ubah format hurufnya, kemudian beri warna putih.

Gambar 4.17 Mengubah tulisan
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5. Buat  objek  pertama  dengan  Bezier  Curves  and  Straight  Lines,  kemudian  ubah 
dengan menggunakan Edit Path, dan beri warna putih seperti gambar berikut ini.

Gambar 4.18 Membuat objek pertama

6. Buat  empat  buah  objek  elips  yang  berbeda  ukuran  dan  letakkan  dengan  posisis 
seperti Gambar 4.19.

Gambar 4.19 Logo GNOME

7. Seleksi  objek  pertama dan empat  buah  elips  menggunakan Select  and  Tansform 
Objects, lalu klik menu Edit → Duplicate. Beri warna yang berbeda dan klik tombol 
PgDn sampai menjadi seperti gambar di atas.

8. Aturlah semua objek menjadi seperti Gambar 4.20.
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Gambar 4.20 Logo GNOME Asia Summit

9. Simpan dengan nama file praktikum02_nama_kelas.

C.  MEMBUAT GAMBAR VEKTOR MOBILC.  MEMBUAT GAMBAR VEKTOR MOBIL
Latihan ketiga ini merupakan latihan untuk lebih meningkatkan kemampuan Anda dalam 
berkreasi  membuat  gambar  vektor  menggunakan  Inkscape.  Latihan  ketiga  ini 
membutuhkan  ketelitian  dan  kesabaran  lebih.  Sering-seringlah  menyimpan  file  dengan 
menekan tombol Ctrl + S sebab di akhir proses pembuatan, komputer Anda mungkin akan 
menjadi  lambat  karena  banyaknya  objek  yang  Anda  buat.  Selamat  mencoba  langkah-
langkah berikut ini.

1. Siapkan dokumen dengan ukuran B6 dengan orientasi landscape.

Gambar 4.21 Pengaturan dokumen

2. Buat  objek  bodi  mobil  dengan  menggunakan  Bezier  Curves  and  Straight  Lines 
seperti gambar berikut ini.
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Gambar 4.22 Bodi mobil dengan bezier curves and straight lines

3. Ubah  bentuk  bodi  mobil  tadi  dengan  menggunakan  Edit  Path  menjadi  seperti 
Gambar 4.23.

Gambar 4.23 Bodi mobil setelah diedit dengan Edit Path

4. Buat objek kaca depan mobil dengan Bezier Curves and Straight Lines, kemudian 
ubah dengan Edit Path dan beri warna. Perhatikan Gambar 4.24 agar lebih jelas.

Gambar 4.24 Kaca depan mobil

5. Dengan cara yang sama, buat kaca bagian samping (perhatikan Gambar 4.25).

Gambar 4.25 Kaca samping mobil

6. Buat objek roda dengan menggunakan kotak sudut tumpul, dan dua buah elips. Beri 
warna dan aturlah posisinya seperti Gambar 4.26.
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Gambar 4.26 Membuat roda

7. Letakkan kotak sudut tumpul tadi ke posisi di belakang bodi dengan tombol PgDn 
pada keyboard. Lakukan hal yang sama kepada kedua elips.

8. Buat objek bawah bodi mobil bagian roda dengan menggunakan Bezier Curves and 
Straight Lines, ubah dengan Edit Path, dan beri warna (Gambar 4.27). Tekan tombol 
PgDn pada keyboard untuk meletakkannya di belakang roda.

Gambar 4.27 Sparkboard roda depan

9. Buat  objek  roda  bagian  kanan dengan menggunakan  Bezier  Curves  and Straight 
Lines,  dan  ubah dengan Edit  Path.  Kemudian,  buat  elips  dan beri  warna  seperti 
Gambar 4.28.

Gambar 4.28 Membuat roda depan sebelah kanan

10. Buat  roda  bagian  belakang  dengan  langkah  seperti  langkah  nomor  6  sampai  7. 
Perhatikan Gambar 4.29 agar lebih jelas.
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Gambar 4.29 Membuat roda belakang

11. Buat juga bagian bawah bodi belakang roda seperti langkah nomor 8.

Gambar 4.30 Sparkboard roda belakang

12. Buat penutup mesin mobil pada bagian bodi dengan menggunakan Bezier Curves 
and Straight Lines, ubah dengan Edit Path, dan beri warna.

Gambar 4.31 Kap mesin mobil

13. Beri warna pada bodi mobil.

Gambar 4.32 Warna mobil
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14. Pada bagian depan mobil (lampu dan aksesoris), buat dua buah kotak sudut tumpul, 
empat buah elips dan satu buah kotak persegi panjang dan atur posisinya seperti 
Gambar 4.33.

Gambar 4.33 Bagian depan mobil

15. Buat dua buah elips, beri warna abu-abu, kemudian atur posisi seperti gambar, dan 
tekan tombol PgDn pada keyboard untuk menghasilkan efek seperti Gambar 4.34.

Gambar 4.34 Lampu depan mobil

16. Buat  bagian  untuk  penampilan  bodi  di  atas  roda  agar  terlihat  menarik  dengan 
menggunakan Bezier Curves and Straight Lines dan ubah dengan Edit Path seperti 
gambar berikut ini.

Gambar 4.35 Vender depan

17. Beri warna cerah untuk Fill dan Stroke, lalu beri efek gradasi atau perpaduan warna 
dengan menggunakan Create and Edit  Gradient  pada Toolbox. Klik kanan objek, 
pilih  Fill  and  Stroke,  klik  bagian  Stroke,  kemudian  beri  efek  blur  sebesar  2,8. 
Perhatikan Gambar 4.36 agar jelas.
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Gambar 4.36 Efek vender depan

18. Lakukan hal yang sama untuk bagian belakang mobil.
19. Buat bagian bumper depan mobil dengan menggunakan Bezier Curves and Straight 

Lines, ubah dengan Edit  Path, kemudian gandakan bemper dengan menu Edit  → 
Duplicate. Beri warna yang berbeda dan atur posisi seperti gambar berikut ini.

Gambar 4.37 Bumper depan mobil

20. Tekan tombol PgDn pada keyboard untuk bumper yang warna cerah, lalu klik kanan 
klik Fill and Stroke. Pada bagian stroke beri efek blur sebesar 0,8. 

Gambar 4.38 Efek bumper depan mobil

21. Agar ada efek yang menarik pada penutup mesin bagian depan bodi, buat tiga buah 
objek dengan menggunakan Bezier  Curves  and Straight  Lines,  ubah dengan Edit 
Path dan beri warna cerah. Lakukan hingga menjadi seperti Gambar 4.39.
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Gambar 4.39 Efek kap mesin mobil

22. Buat lampu bagian belakang mobil dengan Bezier Curves and Straight Lines, lalu 
gandakan dan atur posisinya seperti gambar berikut ini.

Gambar 4.40 Membuat lampu belakang mobil

23. Buat lampu sen bagian depan dengan menggunakan dua buah kotak sudut tumpul 
yang berbeda warna, aturlah posisi kedua objek tadi hingga menjadi seperti gambar 
berikut ini.

Gambar 4.41 Membuat lampu sen depan

24. Lakukan hal yang sama untuk lampu sen sebelah kanan.
25. Lampu sen bagian belakang mobil, buat dengan Bezier Curves and Straight Lines, 

kemudian beri warna.
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Gambar 4.42 Membuat lampu sen belakang

26. Beri  efek  pintu  dengan  menggunakan  Bezier  Curves  and  Straight  Lines,  atur 
posisinya hingga seperti Gambar 4.43, kemudian beri warna cerah.

Gambar 4.43 Efek pintu mobil

27. Berikan efek cahaya pada bagian kaca dan atap mobil dengan menggunakan bezier 
curves hingga seperti gambar berikut ini.

Gambar 4.44 Efek cahaya

28. Buat  bagian  wipper  dan  splash  water  dengan  menggunakan  bezier  curves  dan 
lingkaran posisikan hingga seperti gambar berikut ini.
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Gambar 4.45 Wipper dan Splash water

29. Buat spion mobil menggunakan kotak sudut tumpul dan bezier curves, beri warna 
dan efek cahaya. Lakukan hingga menjadi seperti gambar berikut ini.

Gambar 4.46 Spion mobil

30. Beri  efek  bayangan pada  bagian  bawah mobil  dengan  menggunakan kotak  yang 
dimiringkan beri warna galap atau abu-abu pada fill dan strokenya.

Gambar 4.47 kotak untuk bayangan

31. Klik kanan pada objek kotak, klik Fill and Stroke. Pada bagian stroke, beri efek blur 
sebesar 9,0 dan tingkat transparan gambar (opacity sebesar 98,4%. Tekan tombol end 
pada keyboard. Perhatikan gambar berikut ini.
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Gambar 4.48 Efek bayangan mobil

32. Beri plat nomor kendaraan dengan kotak dan teks seperti gambar berikut.

Gambar 4.49 Plat nomor mobil

33. Buat plek ban dengan menggunakan satu buah elips dan enam objek bebas dengan 
bezier curves, lalu beri efek cahaya dengan bezier curves. Lakukan hingga menjadi 
seperti gambar berikut ini.

Gambar 4.50 membuat velg mobil

34. Gandakan  (duplicate)  velg  mobil  depan tadi,  lalu  satukan  (grub)  dengan tombol 
CTRL + G, kemudian posisikan untuk ban bagian belakang.

35. Terakhir, beri latar belakang warna cerah pada dokumen agar terlihat lebih menarik. 
Perhatikan gambar berikut ini.
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Gambar 5.51 gambar vektor mobil

36. Simpan dengan nama file praktikum03_nama_kelas.

D. RANGKUMAND. RANGKUMAN
Inkscape dapat  Anda gunakan untuk membuat berbagai objek dan gambar yang sangat 
menarik, contohnya stempel, logo, dan gambar mobil. Kemampuan Inkscape tidak kalah 
dibanding dengan program pengolah gambar vektor lain yang lebih terkenal. Ragam kreasi 
yang dapat Anda hasilkan dengan Inkscape sangat bergantung pada kreativitas Anda.

E. ISTILAH-ISTILAH PENTINGE. ISTILAH-ISTILAH PENTING

ISTILAH ARTI

 Blur Efek memudarkan warna atau garis pada objek.

 No Paint Tidak ada warna, menghilangkan warna.

 Opacity Efek transparan suatu objek.

 PgDn Page Down, berpindah ke bawah atau belakang.

 Popup menu Menu yang muncul saat mouse di klik kanan pada layar monitor
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F. EVALUASIF. EVALUASI
a. Soal Pilihan Ganda 
Pilihlah jawaban yang paling tepat.

1. Menu yang berguna untuk mengubah tulisan atau huruf adalah....
 a. File
 b. Edit
 c. Object
 d. Path
 e. Text

2. Bagian  dari  Toolbox  yang  berfungsi  mengubah  suatu  objek  menjadi  objek  lain 
adalah....
 a. Select and Transform Objects
 b. Edit Path
 c. Freehand Lines
 d. Bezier Curves and Straight Lines
 e. Fill Bounded Areas

3. Shortkey pada keyboard yang berguna untuk menggabungkan (grouping) beberapa 
objek adalah....
 a. CTRL + C
 b. CTRL + V
 c. CTRL + Y
 d. CTRL + D
 e. CTRL + G

4. Fungsi di bawah ini yang berguna untuk menggandakan suatu objek adalah....
 a. Combine
 b. Duplicate
 c. Put on Path
 d. Zoom
 e. Union

5. Submenu yang dapat Anda gunakan untuk menghilangkan warna garis  pada suatu 
objek adalah....
 a. Fill and Stroke
 b. Document Properties
 c. Copy
 d. Paste
 e. Object Properties

6. Tombol pada keyboard yang berguna untuk memindahkan posisi objek ke belakang 
objek di bawahnya adalah....
 a. PgUp
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 b. PgDn
 c. End
 d. Home
 e. Del

7. Tombol  pada  keyboard  yang  berguna  untuk  memindahkan  posisi  objek  ke  depan 
objek di atasnya adalah....
 a. PgUp
 b. PgDn
 c. End
 d. Home
 e. Del

8. Tombol  pada  keyboard  yang  berguna  untuk  memindahkan  posisi  objek  ke  posisi 
paling belakang adalah....
 a. PgUp
 b. PgDn
 c. End
 d. Home
 e. Del

9. Shortkey pada keyboard yang berfungsi untuk menggandakan objek adalah....
 a. CTRL + S
 b. CTRL + C
 c. CTRL + D
 d. CTRL + G
 e. CTRL + V

10. Efek warna yang berfungsi memadukan beberapa warna adalah....
 a. Fill
 b. Gradients
 c. Connectors
 d. Combine
 e. Difference

b. Soal Teori 
Kerjakan pertanyaan-pertanyaan berikut ini.

1. Tuliskan cara untuk mengubah objek kotak menjadi objek bebas atau sembarang!
2. Tuliskan cara untuk membuat efek blur pada objek!
3. Apa kegunaan fungsi Duplicate?
4. Bagaimana cara membuat kotak sudut tumpul?
5. Tuliskan cara menyimpan dokumen Inkscape ke folder Documents!
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c. Soal Praktik 
Kerjakan soal praktik berikut ini.

1. Bukalah program Inkscape.
2. Buatlah gambar seperti berikut.

a. Stempel Blankon (simpan dengan nama blankon_nama_kelas).

b. Logo GNOME SUMMIT (simpan dengan nama gnome_nama_kelas).

c. Mobil (simpan dengan nama mobilku_nama_kelas).
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MENU DAN IKON PADA GIMPMENU DAN IKON PADA GIMP

STANDARD KOMPETENSISTANDARD KOMPETENSI
➢ Menggunakan perangkat lunak pembuat grafis bitmap dan vektor.

KOMPETENSIKOMPETENSI DASAR DASAR
➢ Menunjukkan menu ikon yang terdapat dalam perangkat lunak grafis bitmap.

PETA PETA KONSEPKONSEP
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MENU DAN IKON GIMP

Pengenalan Gimp Deskripsi program

Memulai Gimp

Sejarah Gimp

Kegunaan Gimp

Jenis File

Application

Graphic

Gimp

Jendela Kerja

Tool Options

Brushes

Layers

Pattern

Gradient

Tip of The Day



PENGANTAR BABPENGANTAR BAB
i setiap bidang pekerjaan, peranan desain grafis sangat besar dan menentukan. 
Sebuah  produk  yang  didesain  secara  menarik  akan  lebih  mudah  dipasarkan. 
Desain grafis  yang menarik juga akan menghasilkan karya yang lebih mudah 

dipahami dan dicerna masyarakat luas. 
D
Salah satu objek desain yang banyak digunakan oleh desainer grafis adalah gambar berupa 
bitmap image. Perangkat lunak aplikasi yang secara khusus menyediakan fasilitas-fasilitas 
pengolahan  gambar  bitmap  diperlukan  untuk  mengubah  gambar  bitmap  biasa  menjadi 
tampilan yang lebih spektakuler. Dalam bab ini,  Anda akan mengenal GIMP, perangkat 
lunak open source yang dirancang khusus untuk keperluan desain grafis. 

A.  MENGENAL PROGRAM GIMP A.  MENGENAL PROGRAM GIMP 
GIMP adalah salah satu program alternatif yang dapat digunakan untuk mengolah gambar 
bitmap.  Selain  bersifat  free  dan  multiplatform,  GIMP menyediakan  fasilitas  mengolah 
gambar yang unik dan powerfull.  Program pengolah grafis ini pertama kali dirilis pada 
tahun 1995 oleh Spencer Kimball dan Peter Mattis, kemudian terus dikembangkan oleh 
sekelompok ahli desain grafis digital dibawah bendera GNU yaitu sebuah komunitas yang 
menggelorakan open source software. 
Awalnya, GIMP hanya dapat berjalan pada sistem operasi Linux, namun sekarang dapat 
dijalankan di atas sistem operasi Windows. Output gambar yang dihasilkan pun sangatlah 
bervariasi, mulai dari GIF, JPEG, TIFF, BMP, dan lain sebagainya. Cara kerja dan efek-
efek yang disediakan memang berbeda dengan program pengolah gambar bitmap lainnya. 
Akan tetapi, banyak sekali efek dan fitur pada GIMP yang tidak akan Anda jumpai pada 
program desain grafis yang lain.

B.  MEMULAI GIMPB.  MEMULAI GIMP
Untuk memulai menggunakan GIMP, langkah-langkah yang harus Anda lakukan hampir 
sama dengan ketika Anda mengaktifkan Inkscape, yakni sebagai berikut.

1. Klik Applications.
2. Selanjutnya pilih grafis.
3. Klik ikon GIMP Image Editor.

7878        MENU DAN IKON PADA GIMPMENU DAN IKON PADA GIMP  



Gambar 5.1 membuka GIKMP

C.  MENGENAL BARIS MENUC.  MENGENAL BARIS MENU
Setting  awal  ketika  GIMP diaktifkan  adalah  akan  ditampilkan  3  jendela  utama secara 
terpisah satu sama lain. Paling depan akan ditampilkan jendela Tip of The Day, jendela 
Layer, dan paling bawah adalah jendela The GIMP yang terdiri dari kumpulan tool. Baris 
menu yang dapat digunakanpun cukup banyak; tempatnya terpisah dan terbagi menjadi 3 
bagian, yaitu:

1.1. Baris menu di dalam jendela utama The GIMPBaris menu di dalam jendela utama The GIMP

Baris menu ini langsung terlihat begitu program GIMP dijalankan. Terdapat 3 menu dalam 
jendela utama, yaitu File, Xtns, dan Help. 

Gambar 5.2 Menu utama

Di dalam menu File terdapat perintah-perintah yang berhubungan dengan berkas atau file 
yang yang dikerjakan, misalnya:

1. New (untuk membuat berkas baru)
2. Open (untuk membuka berkas atau gambar yang ada)

MENU DAN IKON PADA GIMPMENU DAN IKON PADA GIMP      7979



3. Quit (untuk untuk keluar dari program).

2.2. Baris menu di dalam jendela Baris menu di dalam jendela areaarea kerja kerja

Deretan menu-menu ini hanya dapat dilihat, jika membuat dokumen yang baru. Oleh sebab 
itu buatlah file baru dengan cara seperti yang dijabarkan pada Bab 6:

Klik menu File
Klik New
OK

Dan jika diperhatikan dengan seksama, di bagian atas jendela area kerja terdapat 11 menu 
yaitu: File, Edit, Select, View, Image, Layer, Tools, Dialogs, Filters, Phyton-Fu, dan Script-
Fu

Gambar 5.3 Menu bar di jendela area kerja

Menu-menu  yang  terlihat  berfungsi  untuk  mengatur  segala  sesuatu  yang  berhubungan 
dengan pengolahan gambar bitmap yang akan diolah.

3.3. Baris menu melalui klik kanan pada area kerjaBaris menu melalui klik kanan pada area kerja

Deretan menu yang dimaksud sebenarnya sama dengan baris menu yang disebutkan diatas. 
Yang membedakan adalah letak menu-menu tersebut,  yang dapat dijumpai dimana saja 
disekitar area kerja. Dan cara menampilkannya sangatlah mudah cukup dengan menekan 
tombol mouse sebelah kanan.

Gambar 5.4 menu yang dihasilkan dari klik kanan

Sama seperti deret menu sebelumnya, menu-menu ini digunakan untuk mengolah bitmap 
menjadi suatu hasil karya yang menarik.
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D. MENGENAL TOOLBOX THE GIMPD. MENGENAL TOOLBOX THE GIMP
Jendela The GIMP adalah jendela utama yang harus dalam keadaan aktif atau ada kalau 
ingin menggunakan program GIMP. Dan jika jendela The GIMP diclose, maka program 
GIMP akan dinonaktifkan.  Dibawah deretan  menu pada jendela  ini  ditampilkan  begitu 
banyak tool yang dapat digunakan untuk membuat objek gambar ataupun memodifikasi 
gambar.

Gambar 5.5 ToolBox di jendela The Gimp

Seperti layaknya sebuah program pengolah gambar bitmap, sebagian besar tool-tool yang 
disediakan  GIMP  berfungsi  untuk  mengolah  gambar.  Berbeda  dengan  inscape  yang 
berfungsi lebih kepada penciptaan objek gambar, maka GIMP sangat kaya dengan efek-
efek gambar yang unik, bervariasi dan menarik.
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Gambar 5.6 Tool-Tool pada GIMP

E.  MENGENAL TOOL OPTIONE.  MENGENAL TOOL OPTION
Jendela  Tool Option  terletak  di  bagian  bawah toolbox.  Fungsi  utama dari  Tool  Option  ini 

adalah untuk mengatur properties atau atribut suatu tool yang diaktifkan di dalam Toolbox. Secara 
otomatis, tampilannya akan berubah sesuai dengan jenis tool yang diklik. Sebagai contoh jika Anda 
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klik tool Paint Fuzzy Brush Strokes maka tampilan jendela Tool Option akan tampak seperti pada 
Gambar 5.6. Untuk menampilkan jendela Tool Option, Anda dapat menekan tombol Shift + Ctrl + 
T pada keyboard.

Gambar 5.7 Tool Option untuk Paintbrush

Terlihat pada gambar di atas, atribut tool yang dapat diubah, adalah:
● Opacity: tingkat transparansi objek gambar
● Mode: tipe kuas yang digunakan
● Brush: bentuk dan ukuran kuas
● Pressure sensitivity: sensitivitas garis yang dibuat

Beberapa tool dalam Toolbox yang penting dan perlu Anda pelajari adalah:

1.1. LayersLayers

Setiap objek gambar  yang dibuat  dapat  diletakkan di  dalam kertas kerja  yang berbeda 
sehingga pengeditan gambar lebih aman dan terstruktur.  Prinsip layer yang ada bertujuan 
untuk  memudahkan  proses  pembuatan  dan  pengeditan  gambar.  Jumlah  layer  yang 
digunakan pada awalnya adalah 1 layer, tetapi dapat ditambah ataupun dikurangi sesuai 
dengan kebutuhan. 
Proses penambahan layers dapat dilakukan dengan cara:

● Klik menu Layer
● Klik New Layer
● OK

Dan untuk menghapus suatu layer, langkah yang harus dilakukan adalah:
● Klik layer yang akan di hapus
● Klik menu Layer
● Klik Delete Layer
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Gambar 5.8 Jendela Layers

Selain  melalui  menubar,  penambahan  dan  pengurangan  jumlah  layer  dapat  dilakukan 
melalui klik kanan pada layer Background. Kemudian klik pilihan  New layer jika ingin 
ditambahkan,  atau  klik  pilihan  Delete  layer jika  ingin  dihapus.  Untuk  menampilkan 
jendela Layers, gunakan shortcut key Ctrl + L.

2.2. BrushesBrushes

Merupakan sebuah jendela yang berisi bentuk-bentuk garis yang dapat dibuat. Walaupun 
nama jendela ini adalah Brushes, tetapi bukan berarti hanya berlaku untuk tool PaintBrush 
saja. Bentuk garis yang disediakan berlaku untuk:

● Paint hard edged pixels (Pencil)
● Paint fuzzy brush strokes (Paintbrush)
● Erase to background or transparency (Eraser)
● Airbrush with variable pressure (Airbrush)
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Gambar 5.9 Jendela Brushes

Dengan hanya membedakan bentuk garis yang dibuat ternyata menjadikan gambar lebih 
artistic  dan  menarik.  Apalagi  ketika  menggunakan  tool  yang  berbeda  misalnya 
menggunakan Pencil dan Airbrush, semakin nyatalah perbedaan keindahan gambar yang 
dibuat.  

3.3. PatternPattern

Tampilan suatu gambar akan tampak lebih mempesona jika dalam teknik pewarnaan yang 
diberikan tidak hanya berupa warna atau kombinasi beberapa warna saja. Oleh sebab itu, 
GIMP memberikan fasilitas Pattern, yang ditujukan untuk menentukan corak atau motif 
gambar  yang diinginkan.  Corak  gambar  yang tersedia  sangatlah  bervariasi,  dan  proses 
pewarnaan objeknya sangatlah mudah.

Gambar 5.10 Jendela Patterns

Untuk menampilkan jendela Patterns, Anda dapat menggunakan shortcut Shift + Ctrl + P. 
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Pemberian corak gambar dapat dilakukan menggunakan tool Bucket Fill, dan jangan lupa 
pada jendela Tool Option ubahlah Fill Type menjadi Pattern fill.

4.4. GradientGradient

Walaupun dengan pengaturan corak gambar saja sudah cukup menjadikan gambar lebih 
indah, tetapi sama seperti program desain grafis yang lain, GIMP menyediakan fasilitas 
untuk mencampur warna atau yang biasa disebut sebagai gradasi warna. Didalam jendela 
gradient ini, banyak racikan warna yang secara instan dapat langsung dipilih sebagai warna 
objek.  Selain itu  terdapat pula fasilitas untuk menentukan warna sendiri  sesuai  dengan 
perubahan warna yang diinginkan. 

Gambar 5.11 Jendela Gradients

Jendela Gradient dapat Anda tampilkan dengan menekan tombol Ctrl + G pada keyboard. 
Proses pewarnaan gradient berbeda dengan proses pewarnaan menggunakan fill bucket. 
Jika menggunakan fill bucket cukup dengan klik mouse pada gambar, sedangkan untuk 
gradient harus di drag atau klik dan seret mouse sehingga membentuk suatu garis warna.

5.5. Tip of the DayTip of the Day

Merupakan sebuah jendela yang menampilkan berbagai trik berbeda dalam menggunakan 
GIMP. Jika tidak ingin terganggu dengan penampilan jendela ini setiap kali menjalankan 
GIMP, maka hilangkan tanda checklist pada pilihan Show tip next time GIMP starts. 
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Gambar 5.12 Jendela Tip of the Day

F. RANGKUMANF. RANGKUMAN
GIMP merupakan sebuah program open source untuk mengolah gambar bitmap dengan 
kemampuan yang cukup baik dan tidak kalah dengan program desain grafis  yang lain. 
Walaupun hanya menyajikan sistem warna RGB dan Grayscale, GIMP mampu mengubah 
tampilan gambar dengan kualitas yang sangat baik. Selain itu, jenis file gambar yang dapat 
diolah GIMP sangat lengkap. 
Jendela-jendela yang terdapat di GIMP sangat unik dan posisinya terpisah satu sama lain. 
Bentuk dan fungsi tool-tool pada GIMP tidak jauh berbeda dengan yang tool disediakan 
oleh program desain grafis lainnnya, sehingga pengguna tidak akan menemui kesulitan saat 
mengolah gambar. Pilihan efek gambar yang disediakan GIMP sangat bervariasi , menarik 
dan berbeda dengan efek yang disediakan oleh program lain.

G. ISTILAH-ISTILAH PENTINGG. ISTILAH-ISTILAH PENTING

ISTILAH ARTI

Bitmap image Gambar  yang  terdiri  dari  kumpulan  pixel  warna.  Biasanya  berupa 
gambar yang diperoleh secara langsung dari alat pengambilan gambar 
seperti kamera atau scanner.

Corak Warna objek berupa gambar atau coretan-coretan garis berstruktur.

Gradasi warna Warna yang menampilkan perubahan warna 1 ke warna 2.

Output gambar Hasil akhir pengolahan gambar.

Properties Sifat-sifat tool atau fasilitas yang dapat diatur sehingga tampilan objek 
gambar yang dibuat menggunakan tool tersebut berbeda.

Sensitivitas garis Kuat  tidaknya  tekanan  alat  gambar  pada  kertas  yang  akan 
mempengaruhi tingkat ketebalan garis.

Transparansi Tingkat jelas atau tidaknya tampilan sebuah gambar. Semakin kecil 
tingkat  tranparansi  maka  gambar  akan  semakin  samar  atau  tidak 
jelas.
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H.  EVALUASIH.  EVALUASI
a.  Soal Pilihan Ganda 
Pilihlah jawaban yang paling tepat.

1. Salah satu jenis file yang tidak dapat diolah GIMP adalah ....
a. jpg
b. gif
c. bmp
d. doc
e. tiff

2. Jika Inscape digunakan untuk mengolah gambar berupa vektor image, maka GIMP 
digunakan untuk mengolah .... image.
a. camera
b. instant
c. bitmap
d. manga
e. cartoon

3. Ketika diklik kanan pada area kerja, maka akan ditampilkan sederetan baris menu, 
diantaranya adalah menu ....
a. window
b. sound
c. graphic
d. dialog
e. help

4. Perintah Layer + New layer digunakan untuk ....
a. menambah layer
b. menghapus layer
c. membalik objek
d. mengubah letak objek
e. memilih sistem warna

5. Standard jumlah layer di GIMP adalah .... layer.
a. 1
b. 2
c. 3
d. 4
e. 5

6. Brushes  adalah  bentuk-bentuk  garis  yang disediakan  untuk  tool-tool  berikut  ini, 
kecuali ....
a. pencil
b. paintbrush
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c. eraser
d. airbrush
e. gradient

7. Tingkat tranparansi gambar diatur pada bagian ....
a. mode
b. opacity
c. brush
d. pressure
e. sensitivity

8. Tool yang digunakan untuk memilih objek berupa lingkaran adalah ....
a. select retangular regions
b. select elliptical regions
c. select hand-drawn regions
d. select contiguous regions
e. select regions by color

9. New adalah perintah yang dapat dijumpai pada menu ....
a. File
b. Xtns
c. Edit
d. View
e. Filter

10. File + Open adalah perintah yang digunakan untuk ....
a. membuat file baru
b. membuka gambar yang sudah ada
c. keluar dari program GIMP
d. memilih efek gambar
e. mengaktifkan semua jendela

b. Soal Teori
Kerjakan pertanyaan-pertanyaan berikut ini.

1. Bagaimana cara mengaktifkan program GIMP?
2. Apa yang dimaksud dengan Bitmap Image?
3. Jelaskan perbedaan antara Pencil dan Paintbrush?
4. Bagaimana cara menghapus sebuah layer?
5. Apa perbedaan Zoom in dengan Zoom out?

MENU DAN IKON PADA GIMPMENU DAN IKON PADA GIMP      8989



c. Soal Praktik
Kerjakan soal praktik berikut ini.

1. Carilah gambar pohon, hewan, dan benda.
2. Aplikasikan tool Pencil dan Eraser pada gambar-gambar tersebut.
3. Simpan gambar ke dalam folder yang sudah disediakan.
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                        BAB VIBAB VI
MEMBUAT OBJEK DASAR PADA GIMPMEMBUAT OBJEK DASAR PADA GIMP

STANDARD KOMPETENSISTANDARD KOMPETENSI
➢ Menggunakan perangkat lunak pembuat grafis bitmap dan vektor.

KOMPETENSI DASARKOMPETENSI DASAR
➢ Membuat dan mengedit gambar bitmap.

PETA PETA KONSEPKONSEP
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PENGANTAR BABPENGANTAR BAB
arya grafis, baik yang berupa poster, brosur, maupun bentuk lainnya, akan terasa 
biasa  dan  tidak  memiliki  keunikan  jika  hanya  mengandalkan  gambar-gambar 
yang  tersedia.  Agar  karyanya  berkarakter  dan  memiliki  ciri  khas,  seorang 

desainer grafis harus membuat sendiri objek-objek gambar yang sesuai dengan tema dan 
daya kreativitasnya. 

K
Membuat karya desain grafis di atas kanvas sangatlah berbeda dengan membuat desain 
grafis di atas kertas  digital. Di awal, membuat desain grafis atas kertas digital akan terasa 
sulit. Namun, kemampuan tersebut dapat Anda pelajari dan kembangkan dengan latihan 
terus menerus. Anda membutuhkan ketekunan dan kejelian lebih ketika membuat gambar 
dengan program desain grafis seperti GIMP. Semakin sering Anda berlatih, semakin baik 
pula kemampuan Anda untuk membuat sebuah karya desain grafis.

A.  MEMBUAT LEMBAR KERJA BARU A.  MEMBUAT LEMBAR KERJA BARU 
Sebelum membuat karya desain grafis, langkah pertama yang harus Anda lakukan adalah 
menyiapkan lembar kerja baru di mana semua objek gambar akan diletakkan. Langkah-
langkah yang harus Anda lakukan hampir sama dengan langkah membuat lembar kerja 
baru pada program-program lain. Langkah-langkah tersebut adalah sebagai berikut.
● Klik menu File.
● Selanjutnya pilih New atau tekan tombol Ctrl + N sehingga ditampilkan jendela Create a New 

Image seperti yang ditunjukkan pada Gambar 6.1.
● Tentukan ukuran kertas kerja pada bagian Template.
● Tentukan ukuran  gambar  pada Image  Size.  Semakin besar  nilai  Image  Size,  maka  kualitas 

gambar akan semakin bagus tetapi ukuran filenya akan semakin besar.
● Klik OK.

Gambar 6.1 Jendela Create New Image

Setelah mengerjakan langkah-langkah tersebut akan ditampilkan sebuah area kerja dengan 
ukuran dan bentuk sama dengan pengaturan di awal pembuatan file baru. 
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Gambar 6.2 Lembar kerja baru

B.  MENGATUR LAYOUT HALAMAN B.  MENGATUR LAYOUT HALAMAN 
Ada kalanya, lembar kerja baru yang telah Anda persiapkan ternyata tidak sesuai bentuk 
atau ukurannya dengan gambar yang akan Anda buat. Anda tidak perlu khawatir karena 
Anda dapat mengubah jenis kertas, ukuran, sampai dengan sistem warna dengan mudah.

Mengubah ukuran gambarMengubah ukuran gambar

Berbicara tentang ukuran gambar, ada 2 hal yang harus Anda pahami perbedaannya, yaitu 
Canvas Size dan Image Size. Canvas Size adalah fasilitas yang disediakan GIMP untuk 
mengubah area kertas kerja,  sementara Image Size digunakan untuk mengubah ukuran 
objek gambar dan luas area kertas kerja secara bersamaan. Jadi, jika yang akan Anda ubah 
hanya luas kertas kerja, ubahlah Canvas Size dengan langkah-langkah sebagai berikut.
● Klik menu Image.
● Klik pilihan Canvas  Size hingga tampil  jendela Canvas Size seperti  yang ditunjukkan oleh 

Gambar 6.3
● Ketikkan nilai Width untuk menentukan ukuran lebar canvas dan Height untuk tinggi canvas.
● Klik tombol Resize.
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Gambar 6.3 Menentukan ukuran canvas

Seluruh gambar  yang dibuat  berikut  area  kerja  akan berubah ukurannya menggunakan 
fasilitas Image Size. Langkah-langkah yang harus dilakukan adalah sebagai berikut.
● Klik menu Image.
● Klik  pilihan  Scale  Image  sehingga  ditampilkan  jendela  Image  size  seperti  yang 

ditunjukkan oleh Gambar 6.4
● Ketikkan nilai Width untuk menentukan ukuran lebar gambar.
● Ketikkan nilai Height untuk menentukan ukuran tinggi gambar.
● Klik  tombol  Resize.  Usahakan  agar  image  size  tidak  terlalu  besar  karena  akan 

mengakibatkan resolusi dan ukuran file bertambah besar.
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Gambar 6.4 Menentukan image size

C.  MENGUBAH ORIENTASI HALAMANC.  MENGUBAH ORIENTASI HALAMAN
Orientasi adalah bentuk atau posisi halaman tempat membuat objek gambar. Ada 2 jenis 
orientasi yang dapat Anda pilih, yaitu Portrait untuk membuat gambar dengan posisi tegak, 
dan Landscape untuk membuat gambar dengan posisi mendatar.

Dalam program GIMP, penentuan orientasi halaman dapat dilakukan pada saat pembuatan 
file baru (lihat Gambar 6.5) . Namun jika gambar sudah terlajur Anda buat, Anda dapat 
mengubah nilai Width dan Height dalam Canvas Size. Jika Anda menginginkan orientasi 
Protrait,  tentukan  ukuran  Width  lebih  kecil  dari  Height.  Sebaliknya,  jika  Anda 
menginginkan orientasi Landscape, tentukan ukuran Height lebih kecil daripada Width.
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Gambar 6.5 Orientasi halaman

1.1. Menentukan sistem warnaMenentukan sistem warna

Pada GIMP, terdapat 2 pilihan warna yang dapat Anda pilih, yaitu  grayscale dan RGB. 
Sistem warna RGB adalah sistem pewarnaan dengan menggabungkan 3 warna dasar, yaitu 
merah, hijau, dan biru. Grayscale adalah sistem pewarnaan dengan menentukan kualitas 
warna  hitam  dan  putih  yang  disertai  dengan  perhitungan  tingkat  pencahayaan  objek 
gambar.
Untuk  mengubah  sistem  warna  pada  objek  gambar,  lakukan  langkah-langkah  seperti 
berikut.
● Klik menu Image.
● Pilih Mode.
● Klik sistem warna yang diinginkan.

Gambar 6.6 Memilih sistem warna
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2.2. Mewarnai backgroundMewarnai background

Agar tampilan gambar lebih menarik, warna dasar atau biasa disebut sebagai background 
dapat diwarnai dengan satu warna atau campuran warna-warna yang Anda sukai. Sebagai 
contoh,  jika  Anda  menginginkan  background  berwarna  merah,  maka  Anda  dapat 
melakukan langkah-langkah berikut ini.

1. Klik tool Bucket Fill (atau Fill with a Color or Pattern).
2. Perhatikan bahwa pada jendela Tool Option terdapat 3 Fill Type. Pastikan FG Color 

Fill dalam keadaan terpilih.
3. Tentukan warna merah pada kotak warna yang terletak di atas jendela Tool Option.
4. Klik area kerja sehingga berwarna merah.

Selain  diwarnai,  background  pun dapat  dihias  dengan memberikan  corak  atau  pattern 
background tersebut. Caranya sama dengan mewarnai background di atas, hanya saja pada 
jendela Tool Option pilih Pattern Fill dan tentukan pattern yang Anda inginkan.

Gambar 6.6 Memilih sistem warna

D.  MEMBUAT OBJEK GAMBARD.  MEMBUAT OBJEK GAMBAR
Walaupun fungsi utama GIMP adalah untuk mengolah gambar bitmap, tetapi alangkah baiknya 
proses pembuatan objek-objek gambar pada GIMP Anda pelajari sehingga gambar yang Anda edit 
menjadi lebih menarik. Karena dirancang khusus untuk gambar bitmap, maka objek gambar yang 
dapat Anda buat dengan GIMP pun lebih berupa kumpulan pixel warna, bukan kumpulan garis atau 
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kurva.

1.1. Menggambar lingkaranMenggambar lingkaran

Pada program pembuat gambar berbasis vektor, lingkaran dapat dibuat menggunakan tool 
ellipse  atau  circle.  sementara  dalam  GIMP,  lingkaran  dibuat  dengan  membuat  seleksi 
berupa  lingkaran  dan  mewarnainya  dengan  warna  tertentu.  Sebagai  latihan,  ikutilah 
langkah-langkah untuk membuat lingkaran berwarna biru berikut ini.

1. Buatlah file baru dengan cara: 
2. klik File
3. klik New
4. klik OK.

5. Klik tool Select Elliptical Regions.
6. Drag mouse pada area kerja sehingga terbentuk sebuah seleksi berupa lingkaran.
7. Klik tool Bucket Fill.
8. Pada jendela tool Option, pastikan FG Color Fill dalam keadaan terpilih. 
9. Pilih warna biru pada kotak warna.
10. Klik pada area seleksi berupa lingkaran tadi.

Jika  langkah-langkah  di  atas  Anda  lakukan  dengan  teliti,  maka  akan  terlihat  sebuah 
gambar lingkaran berwarna biru seperti Gambar 6.8.

Gambar 6.8 Lingkaran berwarna biru

2.2. Menggambar kotak persegiMenggambar kotak persegi

Proses pembuatan gambar kotak hampir sama dengan pembuatan lingkaran, yaitu melalui 
seleksi  berbentuk kotak dan mewarnainya  dengan warna yang diinginkan.  Untuk lebih 
jelasnya ikutilah langkah-langkah pembuatan gambar kotak berwarna merah berikut ini.
● Buatlah file baru.
● Klik tool Select Rectangular Regions
● Drag mouse pada area kerja sehingga terbentuk sebuah seleksi berupa gambar kotak.
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● Klik tool Bucket Fill.
● Pada jendela tool Option pastikan FG Color Fill dalam keadaan terpilih.
● Pilih warna merah pada kotak warna.
● Klik pada area seleksi berupa kotak tadi.
Jika langkah-langkah di atas Anda lakukan dengan teliti, maka akan terlihat sebuah gambar 
kotak persegi  berwarna merah seperti Gambar 6.9.. 

Gambar 6.9 Kotak berwarna merah

3.3. Menghapus objek gambarMenghapus objek gambar

Sangatlah wajar jika terjadi kesalahan dalam pembuatan gambar. Oleh sebab itu, semua 
program  desain  grafis  menyediakan  fasilitas  untuk  menghapus  gambar.  GIMP 
menyediakan fasilitas penghapusan gambar tersebut dalam tool yang dinamakan Eraser. 
Untuk menghapus gambar, lakukan langkah-langkah berikut.
Buatlah file baru.
Klik tool Paint Hard Edged Pixels (Pencil).
Buatlah gambar seperti tampak pada Gambar 6.10.

Gambar 6.10 Gambar awal
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Klik tool Erase to Background or Transparency (Eraser).
Hapuslah gambar batu yang ada di sudut kiri bawah layar.
Jika langkah-langkah Anda benar, maka gambar batu akan hilang dari layar.

Gambar 6.11 Tampilan gambar setelah proses penghapusan

4.4. Membuat textMembuat text

Objek gambar tidak hanya terbatas pada garis-garis yang membentuk objek-objek dasar 
seperti kotak atau lingkaran, tetapi dapat pula berupa text yang mengandung pesan-pesan 
tertentu sesuai dengan tujuan pembuatan gambar. Pembuatan text dilakukan melalui tool 
bergambar huruf T yang dinamakan sebagai tool Text. 
● Buatlah file baru dengan ketentuan sebagai berikut:

1. Width: 40 millimeters
2. Height: 20 millimeters
3. Orientasi: Landscape
4. Background: Putih

Klik tool Add Text to the Image (Text).
Klik pada layar sehingga ditampilkan jendela pengeditan tulisan.
Ketikkan LATIHAN GIMP.
Pada jendela Tool Option aturlah:

 Ukuran: 40 px
 Warna: Ungu
 Jenis huruf: Lucida Bright
 Justify: Left Justify
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Gambar 6.12 Text editor

 Pindahkan posisi tulisan ke tengah area kerja menggunakan tool Move Layer.

Gambar 6.13Text di tengah area kerja

● Dengan tool Text, buatlah tulisan Text dibuat menggunakan Tool Text
● Atur properties text pada jendela Tool Option hingga memiliki:

● Warna: biru
● Ukuran: 20

● Menggunakan tool Move Layer, pindahkan posisi tulisan seperti pada Gambar 6.14

Gambar 6.14 Text kedua
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● Masih  menggunakan  tool  Text,  buatlah  tulisan  Text  tool  adalah  tool  bergambar 
huruf T.

● Atur ukuran huruf menjadi 15 pixel.

Gambar 6.15 Text ketiga

● Pada program GIMP berlaku sistem layer, sehingga Text 1 terpisah dari Text 2 dan 
Text 3.  Perhatikan posisi  layer-layer yang digunakan dengan menampilkan jendela 
Layers melalui langkah-langkah sebagai berikut.

● Klik menu Dialogs.
● Klik pilihan Layers untuk menampilkan jendela Layers. Text 3 yaitu text yang 

terakhir dibuat terletak pada layer paling atas. Di bawahnya berturut-turut adalah 
Text 2, Text 1, dan Background.
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Gambar 6.16 Posisi layer

● Saat akan mengedit atau menghapus suatu objek, misalnya Text 2, pastikan layer Text 
2 dalam keadaan terpilih atau aktif. Untuk lebih jelas ikuti langkah-langkah berikut ini.

● Klik kanan layer Text 2
● Klik pilihan Delete layer

● Jika dilakukan dengan benar, maka sekarang hanya terdapat 2 baris kalimat, yaitu Text 
1 dan Text 3. 

5.5. Membuat gambar sederhanaMembuat gambar sederhana

Pada  sub  bab  sebelumnya,  Anda  sudah  mempelajari  proses  pembuatan  gambar 
menggunakan Pencil, Selection Tool, dan tool Text. Sekarang, Anda akan belajar membuat 
gambar  dengan memadukan tool-tool  yang ada  sehingga menjadi  sebuah gambar  yang 
lebih bervariasi. 
● Buatlah sebuah file baru dengan ketentuan sebagai berikut:

● Template: A3
● Orientasi: Landscape
● Fill with: White
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Gambar 6.17 Pembuatan file baru

● Berikan gradasi warna biru ke putih sebagai background gambar dengan cara seperti berikut.
● Klik tool Gradient.
● Perhatikan jendela Tool Option. Pastikan pada bagian Gradient terpilih jenis gradasi FG 

to BG (RGB).
● Pada kotak warna aturlah warna biru sebagai warna Foreground dan putih sebagai warna 

Background.

Gambar 6.18 Pembuatan file baru

● Drag mouse dari atas ke bawah pada area kerja yang tersedia sehingga terlihat warna 
dasarnya berupa gradasi warna biru pada bagian atas menjadi warna putih pada bagian 
bawah.

● Buatlah layer baru dengan cara sebagai berikut.
● Klik menu Layer + New layer.
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● Tentukan Name: Rumah dan Layer Fill Type: Transparency.

Gambar 6.19 Pembuatan layer rumah

● Buatlah kotak berwarna dengan cara sebagai berikut.
● Klik tool Select rectangular regions.
● Buatlah kotak pada area kerja.
● Dengan menggunakan Fill Bucket warnailah kotak yang Anda buat.

Gambar 6.20 Gambar kotak

● Menggunakan  cara  yang  sama  dengan  pembuatan  kotak  di  atas,  buatlah  pintu  dan 
jendela, tentu saja dengan warna yang berbeda dengan kotak pertama tadi
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Gambar 6.21 Gambar pintu dan jendela

● Sama dengan langkah yang ke-3, buatlah layer baru dengan ketentuan:
● Name: Atap
● Fill type: Transparency.

● Buatlah gambar atap dengan cara sebagai berikut.
● Klik tool Create and edit path (Path).
● Klik di 4 titik membentuk gambar atap.

Gambar 6.22 Gambar Kurva

● Perhatikan pada bagian Tool Option.
● Klik tombol Create selection from path.

Gambar 6.23 Mengubah kurva menjadi area seleksi
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● Warnai area seleksi gambar atap menggunakan Fill Bucket.

Gambar 6.24 Gambar rumah dengan atap yang sudah diwarnai

● Buatlah layer baru
● Menggunakan  tool  Pencil,  tambahkan gambar-gambar  yang  lain  sebagai  pelengkap gambar 

tersebut. Sebagai contoh, Anda dapat menambahkan gambar pepohonan, gunung, awan, atau 
objek gambar lainnya.

E.  MENYIMPAN FILE DI DALAM GIMPE.  MENYIMPAN FILE DI DALAM GIMP
Gambar  yang  telah  selesai  dibuat  atau  diedit  tentu  saja  harus  Anda  simpan  agar 
terdokumentasi  dengan  baik.  GIMP  menyimpan  file  dengan  cara  yang  agak  berbeda 
dengan  program  aplikasi  yang  lain.  Yang  menjadi  perbedaan  utama  adalah  GIMP 
mengharuskan penulisan ekstensi file yang akan disimpan, sedangkan program yang lain 
tidak.  Ekstensi  untuk file  GIMP sendiri  adalah xcf.  Untuk jelasnya,  simpanlah gambar 
rumah yang sudah dibuat pada latihan sebelumnya dengan cara sebagai berikut.
Klik menu File.
Klik pilihan Save, untuk menampilkan jendela penyimpanan file.
Tentukan nama file: Rumah.xcf
Tentukan folder tempat file pada pilihan Browse for other folders.
Klik tombol Save.
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Gambar 6.25 Jendela penyimpanan file

Jika Anda hendak mengubah jenis file misalnya menjadi file JPG, maka ketika menyimpan 
ulang file ketikkan ekstensi JPG di akhir nama file.

F.  RANGKUMANF.  RANGKUMAN
Objek gambar  dalam GIMP terdiri  dari  kumpulan pixel  warna,  sehingga semua objek 
dibuat  melalui  tool  seleksi  untuk kemudian diberi  warna  tertentu.  Pengolahan gambar 
dilakukan dengan cara mengorganisir objek-obek pada layer yang berbeda. Output file 
yang dihasilkan sangat banyak dan bervariasi, tetapi ketika menyimpan file, Anda harus 
menyertakan ekstensi file.
Gambar dapat  diwarnai  dengan satu warna tertentu,  gradasi  warna,  dan corak gambar 
yang tersedia. Hal itu berlaku juga untuk warna background. Untuk pewarnaan dengan 
satu  warna  dan  corak  gambar,  Anda dapat  menggunakan tool  Fill  Bucket,  sedangkan 
untuk membuat gradasi warna Anda dapat menggunakan tool Gradient.
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G.  ISTILAH-ISTILAH PENTINGG.  ISTILAH-ISTILAH PENTING

ISTILAH ARTI

 Background Tampilan latar belakang.

 Dialogs Salah satu menu dalam GIMP yang berfungsi untuk menampilkan 
jendela-jendela pengolahan gambar.

 Extension Akhiran dari nama file yang menunjukkan jenis-jenis file.

 Foreground Tampilan bagian depan.

 Importing gambar Proses menyisipkan sebuah gambar ke dalam dokumen yang aktif.

 Path Garis atau kurva yang dibuat dengan tool desain grafis.

 Resize Mengubah ukuran sebuah objek gambar, baik menjadi lebih besar 
maupun menjadi lebih kecil dari ukuran semula.

 Sistem Warna Proses pemberian warna objek yang disediakan oleh suatu program 
desain grafis. Sistem warna yang sering digunakan adalah RGB dan 
CMYK.

H.  EVALUASIH.  EVALUASI
a. Soal Pilihan Ganda 
Pilihlah jawaban yang paling benar.

1. Salah satu pekerjaan yang dapat dilakukan menggunakan program GIMP adalah ....
a. membuat surat perjanjian
b. menyusun artikel untuk majalah
c. membuat poster
d. menghitung anggaran rumah tangga
e. memotong movie

2. Ukuran kertas dalam GIMP dapat diubah melalui bagian ....
a. Template
b. Tool Option
c. Layers
d. Dialog
e. Page Setup

3. Ctrl + N adalah perintah yang digunakan untuk ....
a. membuat file baru
b. membuka gambar yang sudah ada
c. menyisipkan file
d. menghapus sebagian gambar
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e. mengubah ukuran kertas

4. Width adalah bagian yang digunakan untuk mengubah ukuran ....
a. tinggi gambar
b. lebar gambar
c. luas area kerja
d. garis yang dibuat
e. area penghapusan objek

5. Posisi halaman tempat membuat objek gambar adalah ....
a. resolusi
b. proporsi
c. scaling
d. orientasi
e. strecth

6. Halaman dengan posisi tegak dinamakan ....
a. stand up
b. line
c. portrait
d. landscape
e. diagonal

7. Salah satu sistem warna yang disediakan oleh GIMP adalah ....
a. CMYK
b. full color
c. monochrome
d. black and white
e. grayscale

8. Tool text adalah tool yang digunakan untuk membuat tulisan. Tool ini dilambangkan 
dengan huruf ....

a. A
b. L
c. T
d. X
e. Z

9. Yang dimaksud dengan justify didalam program GIMP adalah ....
a. bentuk objek
b. perataan text
c. jenis huruf
d. ekstensi file

110110        MEMBUAT OBJEK DASAR PADA GIMPMEMBUAT OBJEK DASAR PADA GIMP  



e. sistem warna

10. Ekstensi file GIMP adalah ....
a. xls
b. xcf
c. odt
d. doc
e. bmp

b. Soal Teori
Kerjakan pertanyaan-pertanyaan berikut ini.

1. Ketika  membuat  layer  baru,  pada  jendela  New Layer  terdapat  kotak  isian Layer 
Name  yang  digunakan  untuk  mengetik  nama  layer.  Mengapa  layer  harus  diberi 
nama?

2. Jelaskan proses penyimpanan file dengan ekstensi JPG.
3. Apa perbedaan canvas size dengan image size?
4. Bagaimana cara mewarnai background gambar dengan corak Pine?
5. Jelaskan langkah-langkah apa saja  yang harus  dilakukan untuk menghapus objek 

gambar.

c. Soal Praktik
Buatlah poster dengan ketentuan di bawah ini.

1. Tema: Kemudahan yang ditawarkan teknologi bagi kehidupan.
2. Tool yang digunakan: Text, Pencil,  Paintbrush, Eraser, Airbrush,  Fill  Bucket, dan 

Gradient.
3. Ukuran kertas kerja: A3
4. Orientasi kertas: Portrait
5. Simpan gambar dalam format JPG.
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                        BAB VIIBAB VII
EFEK GAMBAR PADA GIMPEFEK GAMBAR PADA GIMP

STANDARD KOMPETENSISTANDARD KOMPETENSI
➢ Menggunakan perangkat lunak pembuat grafis bitmap dan vektor.

KOMPETENSIKOMPETENSI DASAR DASAR
➢ Membuat dan mengedit gambar bitmap.

PETA PETA KONSEPKONSEP
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EFEK GAMBAR PADA GIMP

Filters

1.  Blur             
2.  Color           
3.  Noise           
4.  Edge detect  
5.  Enhance       
6.  Generic        
7.  Glass effects 
8.  Light effects
9.  Distorts        
10. Artistic         
11. Map             
12. Render         
13. Web             
14. Animation    
15. Combine      
16. Toys            

Phyton-Fu

Script-Fu

Efek gambar

Alchemy

Distorts

Effects

1. Alchemy       
2. Alpha to logo
3. Animators     
4. Décor            
5. Render          
6. Selection       
7. Shadow         



PENGANTAR BABPENGANTAR BAB
erbeda  dengan  program  pengolah  gambar  vektor  yang  lebih  mengutamakan 
pembuatan bentuk objek,  program pengolah gambar bitmap seperti GIMP lebih 
mengutamakan pengeditan objek gambar yang sudah ada.  Pengeditan gambar 

tersebut dapat berupa penggabungan, pemotongan ataupun pemberian efek-efek gambar. 
Efek gambar yang dapat digunakan untuk mengubah tampilan gambar terbagi menjadi tiga 
jenis, yaitu efek pada Filters, efek pada Phyton-Fu, dan efek pada Script-Fu. Tentu saja, 
setiap efek memiliki kegunaan dan karakteristik yang berbeda-beda. Dalam bab ini Anda 
akan mempelajari pemakaian efek-efek gambar pada GIMP secara mendetil.

B

A.  PENGGUNAAN FILTERS A.  PENGGUNAAN FILTERS 
Pada menu Filters terdapat 16 pilihan efek yang dapat Anda gunakan untuk mengubah 
atau menghias tampilan gambar. Ke-16 sub menu tersebut terbagi lagi menjadi efek-efek 
gambar yang berbeda satu sama lain. Efek-efek yang tersedia berupa penambahan atau 
penghapusan objek  gambar,  pengaturan  tingkat  pencahayaan,  atau  transformasi  secara 
total suatu menjadi objek baru.

1.1. BlurBlur

Gambar yang terlalu jelas menampakkan detail gambar kadangkala justru menunjukkan 
detil-detil buruk pada objek gambar itu sendiri. Disinilah efek Blur dibutuhkan, yaitu agar 
gambar menjadi agak buram sehingga detil-detil objek gambar yang tidak dikehendaki 
dapat disembunyikan.
Ada  beberapa  efek  Blur  yang  tersedia.  Sebagai  contoh,  ikutilah  langkah-langkah 
pemberian efek Gausian Blur berikut ini.

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open, sehingga gambar terbuka.

2. Klik menu Filters.
3. Pilih Blur.
4. Klik pilihan efek Gaussian Blur.
5. Klik OK.
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Gambar 7.1 Pengaturan efek Gaussian Blur

Jika langkah-langkah tersebut Anda kerjakan dengan benar, maka akan tampak gambar 
dengan tampilan agak buram sesuai dengan nilai yang ditentukan pada Blur Radius. 

2.2. ColorColor

Analogi  untuk  efek  ini  adalah  seperti  gambar  yang  tertutup  oleh  plastik  transparan 
berwarna.  Misalnya  Anda  menggunakan  plastik  berwarna  merah,  maka  akan  terlihat 
semua  objek  gambar  bersemu  merah.  Pilihan  warna  yang  tersedia  cukup  bervariasi. 
Sebagai contoh, ikutilah langkah-langkah pemberian efek warna kuning terhadap gambar 
yang ada berikut ini.

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters.
3. Pilih Color.
4. Klik pilihan efek Colorify.
5. Klik pilihan tombol berwarna kuning.
6. Klik tombol OK.
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Gambar 7.2 Pengaturan efek Colorify

3.3. NoiseNoise

Efek yang diberikan kepada suatu gambar sehingga gambar terlihat seolah-olah dalam 
keadaan  terurai  atau  pecah  menjadi  banyak  bagian.  Proses  pemberian  efeknya  dapat 
berupa  penambahan dan  pengurangan bercak-bercak  berwarna  (noise).  Berikut  adalah 
langkah-langkah pemberian efek Noise  Hurl.→

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters.
3. Pilih Noise.
4. Klik pilihan efek Hurl.
5. Klik tombol OK.
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Gambar 7.3 Pengaturan efek Noise  Hurl→

Semakin  besar  nilai  Random seed,  semakin  banyak noise  yang ditempelkan sehingga 
gambar terlihat semakin terurai.

4.4. Edge DetectEdge Detect

Edge adalah efek yang diberikan kepada suatu gambar dengan memperhatikan setiap titik 
dan garis yang membentuk gambar. Dengan pilihan ini dapat dibuat siluet gambar atau 
sketsa gambar yang sudah ada. Berikut adalah langkah-langkah pemberian efek Edge →  
Detection.

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka.
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters.
3. Pilih Edge Detect.
4. Klik pilihan efek Edge.
5. Klik OK.
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Gambar 7.4 Pengaturan efek Edge  Detect→

5.5. EnhanceEnhance

Dengan memberikan efek Enhance, maka detail gambar akan mengalami pengurangan. 
Hasil akhir yang diperlihatkan dari penggunaan efek ini adalah gambar semakin jelas dan 
terang. Hal ini terjadi karena GIMP menghapus beberapa pixel gambar yang dianggap 
tidak perlu. Berikut adalah langkah-langkah pemberian efek Enhance  Despeckle.→

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters.
3. Pilih Enhance.
4. Klik efek Despeckle.
5. Klik tombol OK.
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Gambar 7.5 Pengaturan efek Despeckle

Radius digunakan untuk menentukan luas area pemberian efek.  Black level digunakan 
untuk menentukan komposisi warna hitam, dan White level untuk menentukan komposisi 
warna putih.

6.6. GenericGeneric

Efek untuk menambahkan intensitas cahaya sehingga gambar terlihat  lebih terang dan 
jelas.  Biasanya  efek  Generic  yang  diberikan  berupa  efek-efek  instan  secara  langsung 
tanpa perlu mengedit properties efek gambar. Berikut adalah langkah-langkah pemberian 
efek Generic  Erode.→

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters.
3. Pilih Generic.
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4. Klik efek Erode.
Setelah diberikan efek Erode ini, maka tampilan gambar menjadi lebih terang daripada 
sebelumnya.

7.7. Glass EffectGlass Effect

Efek gambar  yang memperlihatkan  tampilan  gambar  jika  dilihat  dari  balik  gelas  atau 
berbagai  bentuk  lensa.  Lensa  tersebut  dapat  berbentuk  cekung,  cembung,  datar,  atau 
kombinasi dari 3 bentuk tesebut. Perbedaan bentuk lensa akan menimbulkan efek spesial 
yang menarik bagi tampilan gambar. Sebagai contoh ikutilah langkah-langkah pemberian 
efek Glass Effect berikut ini.

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters.
3. Pilih Glass Effect.
4. Klik efek Apply Lens.
5. Klik tombol OK.

Gambar 7.6 Pengaturan Apply Lens
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8.8. Light EffectLight Effect

Jika Glass Effect memperlihatkan efek tampilan gambar jika dilihat dari barik kaca, maka 
Light  Effect  memperlihatkan  tampilan  gambar  jika  disinari  berbagai  jenis  cahaya. 
Tampilan gambar akan tergantung dari kekuatan cahaya, arah cahaya, dan struktur cahaya 
yang diberikan. Agar lebih jelas ikutilah langkah-langkah pencahayaan FlareFX berikut 
ini.

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters
3. Pilih Light Effect
4. Klik efek Flare Effects
5. Klik tombol OK

Gambar 7.7 Pengaturan FlareFX

Posisi  pencahayaan dapat  ditentukan dengan mengklik  titik-titik  tertentu  pada  gambar 
yang tampak didalam jendela pengaturan efek Light Effect – FlareFX.
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9.9. DistortDistort

Dengan efek distort ini maka bentuk gambar akan berubah sesuai dengan pengaturan efek 
gambar. Sebagian besar efek yang disediakan didalam keluarga distort ini adalah untuk 
menampilkan gambar dalam bentuk 3 dimensi. Sebagai contoh, ikutilah langkah-langkah 
pemberian efek Emboss berikut ini

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters.
3. Pilih Distorts.
4. Klik efek Emboss.
5. Klik tombol OK.

Gambar 7.8 Pengaturan efek Emboss

Setelah melalui proses pemberian efek emboss, sekarang gambar terlihat berbeda daripada 
sebelumnya. Gambar terlihat menjadi timbul atau berbentuk 3 dimensi.
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10.10. ArtisticArtistic

GIMP menyediakan fasilitas untuk mengubah gambar bitmap biasa menjadi sebuah karya 
lukisan yang bernilai seni tinggi. Efek Artistic ini memungkinkan sebuah gambar berubah 
menjadi sebuah lukisan dengan berbagai aliran yang berbeda, misalnya menjadi sebuah 
karya dengan aliran realisme, cubisme, naturalisme, ataupun berupa karya abstrak yang 
penuh makna.
Berikut  ini  adalah  langkah-langkah  untuk  membuat  sebuah  gambar  menjadi  tampilan 
sebuah lukisan diatas selembar canvas.

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters.
3. Pilih Artistic.

Gambar 7.9 Pengaturan efek Artistic

4. Klik efek Apply Canvas.
5. Klik tombol OK.
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11.11. MapMap

Penggandaan  objek  gambar  dan  menempatkannya  diberbagai  tempat  yang  berbeda 
sehingga menampilkan efek gambar yang tidak biasa, itulah yang dikerjakan oleh efek 
Map.  Jumlah  objek  yang  digandakan,  ukuran  objek,  dan  tingkat  transparansi  objek 
semakin  memperkuat  kemampuan  efek  Map  ini  dalam  mengolah  gambar  menjadi 
tampilan yang menarik.
Berikut ini adalah langkah-langkah untuk memberikan efek Illusion pada gambar.

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters
3. Pilih Map
4. Klik efek Illusion
5. Klik tombol OK

Gambar 7.10 Pengaturan efek Illusion
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12.12. RenderRender

Merupakan efek dengan kemampuan mengubah seluruh objek gambar menjadi objek lain 
yang benar-benar berbeda tetapi tetap mengikuti alur gambar sebelumnya. Sebagian efek 
didalamnya menampilkan berbagai jenis corak untuk menutup keberadaan gambar yang 
sebenarnya.
Berikut  ini  adalah  langkah-langkah  untuk  memberikan  efek  Diffraction  Pattern  pada 
sebuah gambar.

1. Bukalah file gambar bitmap yang akan diolah dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters.
3. Pilih Render.
4. Pilih Pattern.
5. Klik efek Diffraction Pattern.
6. Klik tombol OK.

Gambar 7.11 Pengaturan efek Pattern

13.13. WebWeb

Efek ini sebenarnya tidak termasuk dalam efek gambar karena lebih difungsikan untuk 
pemotongan  gambar  atau  yang  lebih  dikenal  sebagai  cropping.  Melalui  fasilitas  ini, 
gambar dapat dibagi menjadi beberapa bagian sesuai dengan space dalam halaman web.

14.14. AnimationAnimation

Fasilitas dalam GIMP untuk mengatur format file gambar ke dalam berbagai jenis gambar, 
di  antaranya adalah  animation  image seperti  GIF  Animation.  Melalui  efek  Animation 
inilah diatur segala properties file animasi tersebut.
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15.15. CombineCombine

Digunakan untuk  menggabungkan gambar  yang diolah  dengan  objek  gambar  lainnya. 
Tampilan  gambar  yang  dihasilkan  tidak  sepenuhnya  mengubah  gambar  asli,  hanya 
menambahkan objek gambar lain saja ke dalamnya.
Berikut ini adalah langkah-langkah untuk memberikan efek Film pada gambar.

1. Bukalah file gambar bitmap yang akan diolah dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Filters.
3. Pilih Combine.
4. Klik pilihan Film.
5. Klik tombol OK.

Gambar 7.12 Hasil dari efek Film

16.16. ToysToys

Fasilitas tambahan yang berfungsi hanya sebagai game sederhana. Didalamnya terdapat 2 
pilihan,  yaitu  Gee  Slime  dan  Gee  Zoom.  Jika  pilihan  Gee  Slime  Anda  klik,  akan 
ditampilkan  layar  yang  berisi  gambar  dengan  animasi  percikan  air  didepannya.  Jika 
mouse  Anda  gerakkan,  maka  percikan  air  akan  semakin  besar  mengikuti  pergerakan 
mouse. Dan Gee Zoom pun hampir sama dengan Gee Slime, hanya saja bukan berupa 
percikan air tapi berupa pembesaran gambar.
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B.  PENGGUNAAN PHYTON-FU B.  PENGGUNAAN PHYTON-FU 
Hanya  dalam  progam  GIMP  Anda  dapat  menemukan  pengelompokkan  efek  gambar 
berdasarkan alur efek gambar yang terjadi. GIMP menyediakan efek Phyton-Fu yang akan 
mengolah gambar menjadi sebuah hasil dengan efek mengikuti karakteristik ular Phyton. 
Secara  garis  besar  bentuknya  akan  meliuk-liuk  atau  lentur  seperti  tubuh  seekor  ular. 
Walaupun  jumlah  efek  yang  disediakan  tidak  sebanyak  pada  menu  Filters,  tetapi 
menjadikan  gambar  hasil  pengolahan  GIMP  unik  dan  berbeda  dibandingkan  dengan 
gambar hasil pengolahan program desain grafis yang lain.

1.1. AlchemyAlchemy

Hanya terdapat satu pilihan efek dalam kategori Alchemy, yaitu Clothify, yang dapat Anda 
gunakan jika Anda ingin menampilkan gambar seperti  tekstur kulit  ular yang bersisik. 
Dilihat sekilas, efek Clothify ini hampir sama dengan efek Apply Canvas yang terdapat di 
dalam menu Filters. Sebagai contoh, ikutilah langkah-langkah berikut ini.

1. Bukalah file gambar bitmap yang akan diolah dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Phyton-Fu.
3. Pilih sub menu Alchemy.
4. Klik pilihan Clothify.
5. Klik tombol OK.

Gambar 7.13 Pengaturan efek Clothify
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2.2. DistortsDistorts

Sama dengan efek Distorts yang ada dalam menu Filters, efek ini akan mengubah gambar 
hingga menyerupai bentuk 3 dimensi. Yang membedakan dengan efek Distorts hanyalah 
bentuknya  yang  menyerupai  struktur  tubuh  seekor  ular.  Berikut  ini  adalah  langkah-
langkah yang harus digunakan untuk memberikan efek Whirl and Pinch.

1. Bukalah file gambar bitmap yang akan diolah dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Phyton-Fu.
3. Pilih sub menu Distorts.
4. Klik pilihan Whirl and Pinch.
5. Klik tombol OK.

Gambar 7.14 Pengaturan efek Whirl and Pinch

Hasil yang terlihat dari efek Whirl and Pinch ini adalah gambar akan meliuk-liuk seperti 
bentuk struktur tubuh ular phyton.

3.3. EffectsEffects

Efek  khusus  ini  akan  menjadikan  gambar  terlihat  berbayang  atau  berkabut.  Berbeda 
dengan  efek  Blur  yang  membuat  gambar  menjadi  samar,  efek  yang  ada  pada  menu 
Phyton-Fu ini terlihat seperti terhalang oleh suatu objek lain. Berikut ini adalah langkah-
langkah yang harus digunakan untuk memberikan efek berkabut.
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1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Phyton-Fu.
3. Pilih sub menu Effects.
4. Klik pilihan Add Fog.
5. Klik tombol OK.

C.  PENGGUNAAN SCRIPT-FU C.  PENGGUNAAN SCRIPT-FU 
Menu yang akan dibahas ini menampilkan efek berdasarkan script atau aturan-aturan yang 
sudah disediakan oleh GIMP. Yang unik adalah setiap aturan yang ada dapat Anda ubah 
sesuai  dengan keinginan.  Dengan adanya pilihan menu Script-Fu,  semakin lengkaplah 
efek gambar yang disediakan GIMP. 

1.1. AlchemyAlchemy

Efek ini hampir sama seperti efek Alchemy yang ada di dalam menu Phyton-Fu, tetapi 
tentu saja karena aturan-aturan efek yang ada di dalam menu Script-Fu ini dapat diubah, 
maka  hasilnya  menjadi  lebih  bervariasi.  Sebagai  contoh,  ikutilah  langkah-langkah 
pemberian efek predator berikut ini.

1. Bukalah file gambar bitmap yang akan diolah dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Script-Fu.
3. Pilih sub menu Alchemy.
4. Klik pilihan Predator.
5. Klik tombol OK.
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Gambar 7.15 Pengaturan efek Predator

Efek Predator akan menampilkan gambar dilihat melalui mata seekor predator sehingga 
terlihat sangat menarik. 

2.2. Alpha to LogoAlpha to Logo

Bentuk efek Alpha to Logo berbeda dengan efek-efek sebelumnya, karena hanya berlaku 
untuk file yang minimal memiliki 2 layer. Dapat dikatakan, bahwa efek ini akan menutup 
layer yang terletak di bawah dan menonjolkan tampilan layer di atasnya. Sebagai contoh, 
ikutilah langkah-langkah memberikan efek 3D Outline berikut ini.

1. Bukalah file gambar bitmap yang akan diolah dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Script-Fu.
3. Pilih sub menu Alpha to Logo.
4. Klik pilihan 3D Outline.
5. Klik tombol OK.

3.3. AnimatorsAnimators

Fasilitas  pemberian efek gambar yang menunjukkan seolah-olah gambar bergerak.  Berbeda 
dengan GIF animator yang menampilkan gambar bergerak, efek Animators ini hanya menampilkan 
gambar statis tetapi memiliki alur gambar seperti bergerak. 
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Gambar 7.16 Pengaturan efek Rippling

Sebagai contoh, ikutilah langkah-langkah Ripple berikut ini.
1. Bukalah file gambar bitmap yang akan diolah dengan cara: 

a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Script-Fu
3. Pilih sub menu Animators
4. Klik pilihan Rippling
5. Klik tombol OK

Jika  Anda  melakukannya  dengan  benar,  maka  akan  ditampilkan  gambar  dengan  alur 
bergelombang sehingga  terlihat lebih dinamis,

4.4. DecorDecor

Layer dapat pula dihias dengan menambahkan objek-objek artistik sehingga gambar lebih 
bermakna  dan  apresiatif.  Yang  disayangkan  adalah  objek-objek  artistik  yang  dapat 
ditambahkan  terbatas  pada  objek-objek  yang  disediakan  oleh  GIMP.  Sebagai  contoh 
tumpahnya air kopi dapat digunakan sebagai pemanis tampilan gambar.

1. Bukalah file gambar bitmap yang akan diolah dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Script-Fu.
3. Pilih sub menu Decor.
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4. Klik pilihan Coffee Stain.
5. Klik tombol OK.

Gambar 7.17 Pengaturan efek Coffee Stain

5.5. RenderRender

Efek  untuk  mengubah  warna,  membuat  objek  kubik,  dan  kemudian  menggantinya 
menjadi  seperti  lukisan cat  minyak ini  benar-benar  mampu membuat  gambar  berubah 
secara total. Walupun demikian, tetapi bentuk gambar terdahulu tetap dijadikan sebagai 
alur  dasar  perubahan  objek.  Salah  satu  contohnya  adalah  mengubah  gambar  menjadi 
gambar luapan lava gunung berapi berikut ini.

1. Bukalah file gambar bitmap yang akan diolah dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Script-Fu.
3. Pilih sub menu Render.
4. Klik pilihan Lava.
5. Klik tombol OK.
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Gambar 7.18 Pengaturan efek Lava

6.6. SelectionSelection

Secara khusus, objek atau layer terpilih dapat diberikan efek tertentu. Di antaranya adalah 
dengan memperlihatkan  proses  gambar  nyata  yang perlahan-lahan menjadi  samar  dan 
kemudian tidak tampak. Jika langkah-langkah berikutnya diikuti dengan benar, maka garis 
tepi gambar akan perlahan-lahan menjadi samar.

1. Bukalah file gambar bitmap yang akan diolah, dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Script-Fu.
3. Pilih sub menu Selection.
4. Klik pilihan Fadeoutline.
5. Klik tombol OK.

EFEK GAMBAR PADA GIMPEFEK GAMBAR PADA GIMP      133133



Gambar 7.19 Pengaturan efek Fade Outline

7.7. ShadowShadow

Efek  terakhir  yang  perlu  Anda  pelajari  adalah  Shadow,  suatu  efek  yang  mampu 
memberikan bayangan di belakang gambar. Letak dan ukuran bayangan dapat Anda atur 
sesuai dengan keinginan dan kesesuaian dengan gambar utama. 

1. Bukalah file gambar bitmap yang akan diolah dengan cara: 
a. klik File
b. klik Open
c. tentukan folder dan file gambar yang akan dibuka
d. klik tombol Open hingga gambar terbuka.

2. Klik menu Script-Fu.
3. Pilih sub menu Shadow.
4. Klik pilihan Drop Shadow.
5. Klik tombol OK.
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Gambar 7.20 Pengaturan efek Drop Shadow

Setiap  desainer,  memiliki  kesukaan  dan  gaya  yang  berbeda  dalam mengolah  gambar. 
Tidak semua efek yang disediakan oleh GIMP dapat kita bahas dalam bab ini.  Hanya 
efek-efek yang sering dipakai  sajalah yang dijadikan sebagai  contoh dan pembahasan. 
Anda  dapat  mempelajari  dan  mengembangkan  sendiri  penggunaan  efek-efek  gambar 
tersebut.

D.  RANGKUMAND.  RANGKUMAN
GIMP sebagai pengolah gambar yang termasuk Free Open Source Software menyediakan 
efek-efek gambar yang unik, spesial, dan berbeda dibandingkan dengan aplikasi pengolah 
gambar bitmap lainnya. Efek gambar yang tersedia pada program pengolah gambar GIM 
terbagi menjadi 3 bagian, yaitu:

1. Filters
2. Phyton-Fu
3. Script-Fu

Setiap  efek  gambar  memiliki  ciri  khas  dan  kelebihan  masing-masing  yang  tentu  saja 
berbeda satu sama lain.  Sebagian besar  efek gambar dapat  langsung diberikan kepada 
objek atau area terpilih, tetapi ada beberapa efek yang hanya berlaku dengan kriteria-
kriteria  tertentu,  misalnya hanya dapat  diaplikasikan  pada gambar  dengan  minimal  2 
layer. 
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E.  ISTILAH-ISTILAH PENTINGE.  ISTILAH-ISTILAH PENTING

ISTILAH ARTI

3 Dimensi Jenis gambar yang tidak hanya memiliki panjang dan lebar, tetapi juga 
memiliki kedalaman (depth).

Artistik Suatu karya seni yang indah sehingga bernilai sangat tinggi.

Cubisme Salah  satu  aliran  seni  lukis  yang  menampilkan  karya  dalam  bentuk 
kotak-kotak beraturan.

Dekoratif Penuh dengan hiasan indah

Karakteristik Sifat-sifat yang dimiliki oleh suatu benda.

Layer Lapisan halaman kerja di dalam program pengolah gambar bitmap.

Pixel Satuan ukuran gambar bitmap.

Radius Luas jangkauan efek gambar.

Script Rangkaian  instruksi  agar  komputer  mengolah  data  sesuai  keinginan 
pengguna komputer.

Sub menu Bagian dari menu.

F.  EVALUASIF.  EVALUASI

a.   Soal Pilihan Ganda 
Pilihlah jawaban yang paling tepat.

1. Blur  adalah  efek  yang  dapat  digunakan  untuk  mengatur  tampilan  gambar 
menjadi ....
a. berwarna
b. jelas
c. buram
d. bermotif
e. berkabut

2. Untuk menutup gambar dengan satu warna dominan dapat digunakan efek ....
a. Blur
b. Colorify
c. Edge
d. Transparency
e. Noise

3. Tampilan gambar seperti terlihat dari balik kaca adalah salah satu hasil pengolahan 
gambar melalui efek ....
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a. Render
b. Glass Effect
c. Edge Detect
d. Distort
e. Map

4. Flare FX adalah efek gambar yang terdapat pada sub menu ....
a. Alchemy
b. Animation
c. Combination
d. Glass effect
e. Light effect

5. Bentuk menyerupai gambar 3 dimensi dapat dihasilkan jika kita menggunakan efek 
....
a. Animator
b. Alpha to Logo
c. Combine
d. Distorts
e. Generic

6. Permainan sederhana di dalam GIMP terdapat pada sub menu Filter +  ....
a. Toys
b. Game
c. Alchemy
d. Web
e. Render

7. Decor adalah pilihan efek yang terdapat pada menu ....
a. Filters
b. Phyton-Fu
c. Script-Fu
d. Generic
e. Effect

8. Gambar seolah-olah terkena tumpahan air kopi adalah hasil efek ....
a. Coffee Stain
b. Add Fog
c. Noise
d. Despeckle
e. Toys

9. Drop  Shadow  adalah  efek  yang  dapat  diberikan  pada  suatu  gambar  sehingga 
gambar tersebut ....
a. berwarna
b. berkabut
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c. bergerak
d. memiliki bayangan
e. berlipat ganda

10. Fade Outline adalah efek untuk mengaburkan gambar pada bagian ....
a. tengah gambar
b. atas gambar
c. tepi gambar
d. ujung tulisan
e. text yang dibuat

b. Soal Teori
Kerjakan pertanyaan-pertanyaan berikut ini.

1. Jelaskan perbedaan alchemy yang terletak pada Phyton-Fu dengan alchemy yang 
terletak pada Script-Fu.

2. Bagaimana cara memberikan efek 3d outline?
3. Jelaskan kegunaan efek colorify.
4. Jelaskan perbedaan distorts yang ada pada menu Filters dengan distorts yang ada 

pada menu Phyton-Fu.
5. Jelaskan kegunaan Random seed yang terletak pada efek noise.

c. Soal Praktik
Buatlah poster dengan ketentuan sebagai berikut.

● Tema: Save the world.
● Ukuran kertas kerja: A3.
● Orientasi kertas: Landscape.
● Berikan minimal 3 buah efek gambar.
● Buatlah tulisan dengan batas minimal terdiri dari 9 kata.
● Simpan gambar dalam format JPG.
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                        BAB VIIIBAB VIII
BERKREASI DENGAN GIMPBERKREASI DENGAN GIMP

STANDARD KOMPETENSISTANDARD KOMPETENSI
➢ Menggunakan perangkat lunak pembuat grafis bitmap dan vektor.

KOMPETENSI KOMPETENSI DASARDASAR
➢ Membuat dan mengedit gambar bitmap.

PETA PETA KONSEPKONSEP
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Memilih Objek

Cut dan Copy

HASIL KREASI

Membuat Poster



PENGANTAR BABPENGANTAR BAB
ujuan akhir mempelajari desain grafis adalah mampu membuat hasil karya yang 
diakui  masyarakat  luas.  Dunia  desain  grafis  berkaitan  erat  dengan  dunia 
publishing, misalnya pembuatan tabloid, poster, spanduk, pamflet, leaflet, baliho, 

dan brosur. Di era era globalisasi yang tidak dapat dibendung ini, penyebaran informasi 
dengan karya desain grafis memegang peranan yang sangat penting. Seiring dengan hal 
tersebut, kebutuhan tenaga terampil dibidang desain grafis sangat tinggi. 

T
A.  MEMBUKA GAMBAR A.  MEMBUKA GAMBAR 
Pada bab ini Anda akan mengaplikasikan pelajaran-pelajaran yang telah Anda pelajari 
pada bab sebelumnya untuk membuat sebuah poster. Adapun gambar yang akan Anda 
gunakan terdiri dari 2 buah gambar, yaitu nature.jpg dan gedung.jpg, sedangkan tool-tool 
yang akan Anda gunakan adalah :

1. Select hand-drawn regions
2. Text Tool
3. Move Layer

EraserLangkah pertama untuk membuat poster adalah mengolah file gambar utama yang 
akan dijadikan sebagai dasar poster. Oleh karena itu bukalah file gedung.jpg dengan cara 
sebagai berikut.

1. Klik File.
2. Klik Open.
3. Tentukan folder dan file gambar yang akan dibuka.
4. Klik tombol Open hingga gambar terbuka.
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Gambar 8.1 Jendela untuk membuka gambar

Setelah gambar terbuka, berilah efek yang menarik. Sebagai latihan, berikan efek emboss 
dengan cara sebagai berikut.

1. Klik menu Filters.
2. Pilih sub menu Distorts.
3. Klik pilihan Emboss.
4. Tentukan  nilai Azimuth = 6.
5. Tentukan nilai Elevation = 40.
6. Tentukan nilai Depth = 8.
7. Klik OK.

Jika langkah-langkah tersebut Anda ikuti, gambar akan terdistorsi menjadi gambar timbul 
dan tidak colorfull atau berwarna yang mengesankan ukiran di atas batu atau tembok
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Gambar 8.2 Setting efek Emboss

Simpanlah gambar tersebut dengan cara sebagai berikut.
1. Klik menu File.
2. Klik pilihan Save As.
3. Ketikkan nama file Poster.xcf.
4. Klik tombol Save.

Gambar 8.3 File yang disimpan dengan nama Poster.xcf
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Gambar tersebut disimpan dengan format GIMP atau XCF dengan maksud agar gambar 
tersebut  masih dapat  diedit.  Karena jika sudah berbentuk format  jpg,  gif,  atau format 
gambar lainnya gambar sudah menyatu dan tidak dapat diedit kembali.
Langkah berikutnya adalah membuat tulisan dengan cara sebagai berikut:

1. Klik tool Text.
2. Klik pada area kerja, dan buatlah tulisan “HIDUP ADALAH PERJUANGAN”
3. Aturlah properties text menjadi:

a. Jenis huruf: Arial Black
b. Warna: Hijau tua
c. Ukuran: 60 px
d. Letakkan di tengah-tengah area pada bagian atas.

Gambar 8.4 Properties Tool Text

4. Di bawahnya buatlah tulisan “Proses belajar terus menerus tiada henti” dengan 
parameter:
a. Jenis huruf: Deja Vu Sans Bold
b. Warna: Orange
c. Ukuran: 40 px.
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Gambar 8.5 Properties Tool Text

5. Tampilkan layer dengan cara:
a. klik menu Dialog
b. pilih Layers.

6. Klik layer HIDUP ADALAH PERJUANGAN, dan berilah efek shadow dengan 
cara:
a. klik menu Script-Fu
b. pilih sub menu Shadow
c. klik Drop Shadow
d. klik OK.

Gambar 8.6 Pengaturan efek Drop Shadow

7. Klik layer “Proses belajar terus menerus tiada henti”, dan berilah efek Shadow and 
Bevel dengan cara:
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a. klik menu Phyton – Fu
b. pilih sub menu Effects
c. klik pilihan Drop Shadow and Bevel.

Simpan gambar yang sudah Anda buat dengan cara mengklik menu File + Save.

B.  MEMILIH OBJEK B.  MEMILIH OBJEK 
Langkah berikutnya adalah memilih dan menempelkan objek tambahan kedalam file Poster.xcf 

yang sudah dibuat tadi. Ikuti langkah-langkah berikut ini.
1. Bukalah file nature.jpg dengan cara sebagai berikut:

a. klik menu File
b. klik pilihan Open 
c. tentukan folder tempat file berada
d. klik file nature.jpg
e. klik tombol Open.

2. Setelah  file  terbuka,  pilihlah  bagian  gambar  yang ingin  ditempelkan  ke  dalam file 
Poster.xcf menggunakan tool Select hand-drawn regions.

Gambar 8.7 Memilih object

C.  MENYALIN DAN MEMOTONG OBJEK C.  MENYALIN DAN MEMOTONG OBJEK 
Setelah  bagian  gambar  dipilih,  kopi  atau  potonglah  objek  yang  akan  ditempelkan  ke 
dalam file Poster.xcf tersebut. Perbedaan antara menyalin (copy) dengan memotong (cut) 
objek terletak pada gambar sumbernya. Pada saat Anda mengcopy, maka gambar sumber 
masih ada, sedangkan pada saat Anda memotong, maka gambar sumber tidak ada lagi.
Untuk menyalin gambar, maka ikutilah langkah-langkah berikut ini.

1. Kopi objek yang dipilih dengan cara:
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a. klik menu Edit
b. klik pilihan Copy.

2. Bukalah file Poster.xcf.
3. Tambahkan layer baru dengan cara:

a. klik menu Layer
b. klik  New Layer
c. tentukan Nama layer (misalnya  Gambar 2)
d. tentukan Layer Fill Type = Transparency
e. klik OK.

Gambar 8.8 Membuat layer baru

4. Tempelkan hasil kopi dengan cara:
a. klik menu Edit
b. lik pilihan Paste.
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Gambar 8.9 Hasil Paste

Jika gambar terlalu kecil atau terlalu besar, maka sebelum proses copy dan paste, ukuran 
gambar harus Anda ubah terlebih dahulu dengan cara seperti berikut.

1. Klik menu Image.
2. Klik Scale Image.
3. Tentukan Width dan Height gambar.
4. Klik tombol Scale.
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Gambar 8.10 Pengaturan ukuran gamba

Setelah  ukuran  gambar  diubah,  baru  kemudian  di  Copy,  dan  di  Paste  kedalam  file 
Poster.xcf. Silahkan tambahkan objek dan efek lain agar poster tersebut semakin menarik. 
Jika sudah selesai pastikan file Poster.xcf disimpan ulang dengan mengklik menu File + 
Save.

D. MEMBUAT POSTERD. MEMBUAT POSTER
Sebagai langkah akhir dari pembuatan poster, exportlah gambar hasil pengolahan tersebut 
menjadi file yang dapat dibuka di semua platform, misalnya JPG. Ikuti langkah-langkah 
berikut ini.

1. Bukalah file Poster.xcf.
2. Klik menu File.
3. Klik pilihan Save As.
4. Pada kotak nama file ketikkan Poster.jpg.
5. Klik tombol Save.
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Gambar 8.11 Jendela penyimpanan file

6. Akan muncul jendela Export File (Gambar 8.12)
7. Klik Export.

Gambar 8.12 Jendela Export File

8. Akan muncul jendela penyimpanan JPG.
9. Klik OK.
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Gambar 8.13 Menyimpan sebagai JPG

Sekarang terdapat 2 file poster yaitu Poster.xcf dan Poster.jpg. Demikianlah proses dasar 
pembuatan  poster  dengan GIMP. Teruslah  berkarya  dan  berkreasi  agar  Anda  semakin 
menguasai pembuatan desain grafis menggunakan GIMP.

E.  RANGKUMANE.  RANGKUMAN
Pada  bab  ini  Anda  mempelajari  cara-cara  untuk  membuat  karya  desain  grafis  berupa  poster. 
Gambar yang digunakan terdiri dari 2 buah gambar, yaitu nature.jpg dan gedung.jpg, sedangkan 
tool-tool yang digunakan adalah Select hand-drawn regions, Text Tool, Move Layer, dan Eraser.

F.  ISTILAH-ISTILAH PENTINGF.  ISTILAH-ISTILAH PENTING

ISTILAH ARTI

Baliho Hampir  sama seperti  spanduk, tetapi  biasanya  tidak berbentuk  memanjang 
dan bertujuan untuk menginformasikan kegiatan yang sedang berlangsung.

Colorfull Penuh dengan warna.

Export Mengubah  suatu  jenis  file  menjadi  jenis  file  yang  berbeda  sehingga  dapat 
ditampilkan oleh program lain.

Mengkopi Proses memperbanyak objek yang sama.

Platform Berbagai jenis komputer dengan berbagai jenis sistem operasi.

Publishing Setiap  karya  cetak  yang  dibuat  untuk  mensosialisasikan  sesuatu  kepada 
masyarakat.

Spanduk Suatu karya cetak berupa kain persegi  panjang dengan ukuran yang sangat 
lebar, biasanya dipasang di tepi jalan dengan membawa misi promosi barang 
atau jasa.

Tabloid Alat informasi cetak berupa majalah tetapi lebih tebal.
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G.  EVALUASIG.  EVALUASI

a. Soal Pilihan Ganda 
Pilihlah jawaban yang paling tepat.

 1. Hasil karya publishing yang dituangkan di atas selembar kain dinamakan ....
 a. pamflet
 b. leaflet
 c. booklet
 d. spanduk
 e. brosur

 2. Eraser adalah tool untuk ....
 a. membuat garis
 b. mewarnai objek gambar
 c. menghapus gambar
 d. mengubah sistem warna
 e. mengatur ketebalan garis

 3. Tool untuk memindahkan posisi gambar atau layer yang dibuat adalah ....
 a. Move
 b. Selection
 c. Layer
 d. Resize
 e. Hand-drawn

 4. Saat  menentukan efek emboss,  terdapat  3  nilai  yang harus ditentukan.  Salah satu nilai 
tersebut adalah  ....

 a. Line
 b. Curve
 c. File
 d. Azimuth
 e. Nadir

 5. Save as adalah instruksi untuk  ....
 a. menyimpan file dengan cepat
 b. menyimpan file dengan nama lain
 c. menggabungkan 2 gambar atau lebih
 d. membuat bingkai gambar
 e. menutup gambar dengan objek lain

 6. Agar gambar tetap dapat diedit, maka jenis ekstension file yang harus dipilih adalah ....
 a. jpg
 b. gif
 c. bmp
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 d. xcf
 e. png

 7. Efek shadow terdapat pada menu ....
 a. Dropping
 b. Script-Fu
 c. Phyton-Fu
 d. Effects
 e. Filters

 8. Proses penggandaan objek gambar dilakukan melalui perintah ....
 a. Edit + Copy
 b. Format + Outline
 c. Windows + Tool
 d. Duplicate + View
 e. Send + File

 9. Paste adalah instruksi untuk ....
 a. memotong gambar
 b. menambahkan efek khusus
 c. menempelkan hasil kopi
 d. menggerakkan objek gambar
 e. mengubah struktur gambar

 10. Drop shadow and bevel adalah pilihan efek yang terdapat pada menu ....
 a. Filters
 b. Phyton-Fu
 c. Script-Fu
 d. Illustrator
 e. Animators

b. Soal Teori
Kerjakan pertanyaan-pertanyaan berikut ini.

1. Pada jendela tool Option pilihan tool Text, terdapat banyak bagian yang dapat 
diubah. Tuliskan dan jelaskan minimal 4 bagian yang dapat diubah tersebut!

2. Jelaskan apa yang dimaksud dengan azimuth, elevation, dan depth!
3. Jelaskan perbedaan antara menyalin (copy) dan memotong (cut) gambar!
4. Jelaskan cara memperbesar ukuran gambar!
5. Mengapa  ketika  kita  menambah  layer  baru,  background  harus  berupa 

transparency object?
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c. Soal Praktik
Buatlah poster dengan ketentuan di bawah ini.

 1. Tema: Iklan produk
 2. Tool yang digunakan: semua tool
 3. Ukuran kertas kerja: A3
 4. Orientasi kertas: Portrait
 5. Simpan gambar dalam format JPG, GIF, dan PNG.
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